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Introduction

Welcome to Step by Step
The Step by Step Tutorial for ArchiCAD 8 is designed as a 16-
to 20-hour course that will guide you through a project. By
the end of this course, you should have a basic understanding
of ArchiCAD concepts, tools, drawing techniques and
modeling. The steps highlight the implementation of a
project, methods of design and the application of tools for
construction documents.

The intention of this course is to offer a consistent and
organized process for learning ArchiCAD based on an
architectural project.

Each step guides you through the concept or technique to be
learned, the information necessary to build the exercise, and
what to do for that step. The steps also contain diagrams of
the Toolbox and dialogs that provide quick references to
Tools used in that exercise.

The Concept of a Virtual Building
Architectural software is evolving rapidly from an “automator”
of two-dimensional drafting to a three-dimensional building
simulator. As a result of this evolution, the architect’s ability to
construct a “virtual building” on a desktop computer, to
simulate the building’s behavior both before it is built and
throughout its life cycle, will change the architect’s design
process, fee structure, and relationship with the client,
contractor and the community. In addition to transforming the
architect’s own practice, ownership of the 3D computer
model will carry important competitive advantages in
procuring all future work associated with the same building.

Traditional CAD vs. Virtual Building Technology

So what is the difference between traditional CAD drafting
and Virtual Building Technology? Traditional CAD is the world

of lines, arcs, circles and blocks. With traditional CAD, your
drawing is a 2D representation of how the building will be
built. It is very similar to hand drafting but automated with
computer technology.
With Virtual Building Technology, you construct a building
using building elements: floor slabs, walls, roofs, windows,
doors, stairs and other objects. A Virtual Building uses
intelligent objects to create building elements. With object
oriented CAD, each object in the system represents a building
element with a behavior and intelligence relevant to that
element. For example, the behavior of a door is different than
the behavior of the wood used to construct it. Because you
have the real model of a building, not just a 2D representation
of one, you can ask it building specific questions. For
instance, you can get detailed reports on egress analysis, heat
loss analysis, code compliance or cost takeoffs.

From the virtual model, buildings can be analyzed with
respect to building mass, overshadowing and visual
appearance. ArchiCAD can automatically generate plans,
elevations and sections, perspective views, animations and
virtual reality views.

Integrated Building Information
Architects and building professionals using integrated 3D
CAD software generate a wealth of valuable building
information that can be used for both the traditional
architectural practice as well as for many new fields and
services. Some of the opportunities that can utilize this
information are:

• Building master planning, design and development

• Creation of renderings, animations and virtual reality
scenes

• Production drawings, details and schedules
• Building marketing

• Management of building spaces and assets
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• Post-occupancy studies and simulation of design changes
• Analysis and visualization of product performance over

the building life cycle
• Content development for electronic building component

objects including product data and links to manufacturer
Websites

With ArchiCAD and its Virtual Building Technology,
architects, in partnership with owners, are in a prime position
to assert their central role not only in the initial design of
buildings, but also in their long-term programming,
maintenance and operation.

How Firms use ArchiCAD
As the new age of Virtual Building Technology unfolds,
architecture firms and the building industry must consider
how to effectively apply Virtual Building Technology to
design, production, collaboration and information analysis.
ArchiCAD offers a complete solution and, unlike other CAD
systems, has been built on the foundation of architecture.
With this in mind, there are a variety of architecture firms
using ArchiCAD and its Virtual Building Technology system.
The firms range in size from one-man firms to large
companies and specialize in a variety of projects including
housing, retail, commercial, schools and others. Here is what
several architects have to say about ArchiCAD and their use of
Virtual Building Technology:

House+House Architects (San Francisco, California)

“Part of ArchiCAD’s value lies in modeling and easy
perspectives; you do not need to put a lot of effort into it,”
Steven House said. “But it is worth it to take the extra step to
create views with a different flavor. The results can be very
powerful.”
House+House are very hands on with their projects, working
closely with builders, artisans and craftsmen to ensure that no
detail goes unconsidered. “We are very excited about our

explorations in ArchiCAD,” Steven said. “And the potential it
offers for us to communicate design ideas to our clients, our
builders and ourselves.”

STUDIOS Architecture (Washington, D.C.)

With a tight project timeline, the design team at STUDIOS
appreciated ArchiCAD’s ability to generate three-dimensional
models automatically from the floor plan and section views
allowing them to advance the construction documents, make
design studies and prepare client presentations at the same
time with relatively little additional work.

“Modeling in 3D gives you and your client a chance to look
at a design critically and react to it,” project architect Bill
Deegan said. Deegan also cites that STUDIOS could shave off
critical time by sending QuickTime VR scenes to the client by
e-mail and through an Intranet which links STUDIOS U.S.
offices in Washington, D.C., San Francisco and New York.

The Orcutt/Winslow Partnership (Phoenix, Arizona)

When Orcutt/Winslow began to fully embrace the Virtual
Building method of working, they had to rethink their billing
process. “The time spent on the project is greater up-front, but
the documents phase time and effort has been significantly
reduced”, Winslow said. ArchiCAD’s single, integrated
database allows them to start the input of specific materials
and systems at a much earlier point in the design phase. With
this method, they can show these details at any point, and
comfortably make modifications because any changes made
will be updated in all views. “Our schematic designs show a
much more complete three-dimensional presentation to the
client and allow us to evaluate the design in 3D more
thoroughly at early stages.”
“Office morale and profitability are both on the rise and we
are currently in the process of shifting our project phasing
percentages to take into account the Virtual Building
methodology,” added project manager Russ Sanders. “More
time is expended up front establishing the links from the
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primitive model to the layout sheets. Once this is done, the rest
of the project can be developed within the model. By the time
we have completed the design development phase, we are
actually about 60 percent complete with construction
documents.”

Rockefeller/Hricak Architects (Venice, California)

“We would like to think that the appearance of our work is a
direct result of how it gets built. Using ArchiCAD to build a
‘living’ model of the building helps us to focus on issues and
assist us in making design decisions as the project takes
shape.” The firm is concerned not just how buildings look, but
also how they function over time.
“We need to be able to predict how the building will look 10 to
20 years down the road, because that affects the way we design
it,” Hricak said. “If something is going to wear out in 20 years,
we need to understand how that element interacts with what is
around it. Obviously the structure is not going to wear out, but
windows will be repaired, and equipment will become obsolete.
ArchiCAD helps us be clear about the separation of systems
and get a sense of how the building will perform.”

How This Book and Step by Step
Interactive Work Together
This book (also available in Adobe Acrobat .pdf format on the
ArchiCAD 8 CD-ROM/ArchiCAD Documentation folder) is
divided into seven sections beginning with the introduction of
concepts, then moving through the construction of a Virtual
Building. The Step by Step Interactive acts as a virtual
assistant that answers questions with real-time movies of each
step. All you need to use the interactive is a standard web
browser.

Whenever you see this icon...

...it means there is a QuickTime movie demonstrating the step.

To View the Movies on Windows

Choose the Step by Step Interactive option of the Startup
dialog box of the ArchiCAD 8 CD-ROM or Browse this CD,
open the Step by Step Interactive folder on the ArchiCAD 8
CD-ROM and double-click the file called Step Interactive.htm.
This will open into your default web browser.

To View the Movies on MacOS

Open the Step by Step Interactive folder on the ArchiCAD 8
CD-ROM and double-click the file called Step Interactive.htm.
This will open into your default web browser.

To locate the corresponding movie for a step, use the
information under the CD-ROM icon.
P-1: Indicates the main section, Part 1: Concepts and Tools

S-4: Indicates the step, Step 4: Editing and Notation

M-C: Indicates the movie designation for Step 4, Movie C -
Multiply Exercise

1-4: Indicates the exercise numbers if the movie refers to
more than one exercise

To play the QuickTime movie, simply click the name of the
movie (the name in color with an underline), such as Movie C
- Multiply Exercise. The screen will jump to the movie and
begin playing it.

It is that simple!
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How to Install and Use the Step Files on
Windows
Insert the ArchiCAD 8 CD-ROM into your computer’s CD-
ROM drive. The main dialog box of the installation appears
on your screen, where you can choose from the options by
single-clicking on the appropriate caption:

• Install Step by Step Tutorial
If you have an installed ArchiCAD 8 on your hard drive and
you need only the Step Files, click Step by Step Tutorial
caption and follow the installation procedure. Once
completed, the requested items appear in the existing
ArchiCAD 8 folder. Double-click on them and discover your
new ArchiCAD tutorial files.

Library Manager

If you try to open a Step file and the Library Manager dialog
box appears, asking where the ArchiCAD Object Library is
located on your hard drive, you must:

1. locate the ArchiCAD folder,
2. open it and select the folder called ArchiCAD Library 8,

3. click the Add button in the center of the dialog box,

4. click the Done button.

How to Install and Use the Step Files on
MacOS
Insert the ArchiCAD 8 CD-ROM into your computer’s CD-
ROM drive. The contents of the CD-ROM will appear on your
screen.
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• Install Step by Step Tutorial
If you have an installed ArchiCAD 8 on your hard drive and
you need only the Step Files, click Step by Step Tutorial icon
in the Step by Step Tutorial folder.
A dialog box will ask for the location of your ArchiCAD
folder. Click the Select Folder button to browse your
computer for the requested folder. Click Continue and follow
the installation procedure.

Once completed, the requested items appear in the existing
ArchiCAD 8 folder. Double-click on them and discover your
new ArchiCAD tutorial files.

Library Manager

If you try to open a Step file and the Library Manager dialog
box appears, asking where the ArchiCAD Object Library is
located on your hard drive, you must:

1. locate the ArchiCAD folder,

2. open it and select the folder called ArchiCAD Library 8,
3. click the Add button in the center of the dialog box,

4. click the Done button.

Starting a Tutorial Exercise
When the ArchiCAD 8 version is open on screen, go to the
File Menu and Open the file Step-xx.pln located in the Step
Files folder.
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Part One: Concepts and Tools

Step 1: The ArchiCAD Workplace
Overview

Here you will learn the basic windows of the working environment and how to customize these windows to create your
personal workspace. ArchiCAD has three primary working environments; Floor Plan Window, Section/Elevation Window and
the 3D Window.

Additionally, this step will introduce you to the Tools and Palettes that are used to help you draw and construct building
elements, notes, graphics and views.

Process to Learn

• ArchiCAD Workplace
Floor Plan Window
Section/Elevation Window

3D Window
• Tools & Palettes

Toolbox
Info Box

Coordinate Box
Control Box

Starting the Step

To begin this step, double-click the file named Step-01.pln contained in the Step Files folder.
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Introduction
This step introduces the visible elements of the ArchiCAD working environment. They will help you find your way around the
ArchiCAD workplace and understand the role each component plays in using ArchiCAD.
In many respects, the ArchiCAD workplace is similar to conventional design and drafting environments. We like to think that
ArchiCAD begins where your drafting table leaves off, providing you with actual construction elements designed to create a
virtual building.

The ArchiCAD workplace is designed to provide you with tools that look and feel comfortable, but have all the power and
precision available to a computerized system. Once you have started the program you will see the ArchiCAD Workplace on your
screen, complete with a Floor Plan worksheet, Menubar, Floating Palettes, and other Windows displaying various aspects of the
Virtual Building Project.
You can construct your model in ArchiCAD's main Windows displaying different project views:

- The Floor Plan Window is
the basic construction area
where most editing operations
take place.

- The 3D Window gives you
instant feedback on the
construction operations
performed in other views and
at the same time allows you to
directly edit your model in
either perspective or
axonometric view.

- Any number of Section/
Elevation Windows can be
defined by a dedicated Tool at
any moment, at any location.
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What to Do
This step opens to the ground floor of a two-story building.
Here we can view the three components of ArchiCAD’s
workplace. These three workspaces are linked working
environments. The working environment allows an interactive
drawing process between the Floor Plan, Section/
Elevation and 3D Window. Elements are updated in all
views to reflect current changes to the model.
These three workspaces can be accessed through the Project
Map which is located in the Navigator. Since we do not need
the Customizable Info Box, close it by clicking the "X" button
in the top right corner as shown below.

The Floor Plan Window
The center of the ArchiCAD workplace is the Floor Plan
worksheet. This Window plays two roles at the same time:

- It displays a representation of the project as a traditional
architectural drawing.

- It is a 2D/3D modeling environment that is interactive with
the Sections/ Elevations and 3D workspace.

 P-1, S-1, M-A

With the Floor Plan window open, we can view the plans for
both floors of this building. The model currently shows the
Ground Floor story. To move up a story, open the Stories
section of the Project Map by clicking the "+" symbol and
then double click the Gallery story.

    

The Floor Plan worksheet is like a sheet of drafting paper.
However, a traditional mechanical drafting board is limited by
the size of the paper you can fit on it, while the ArchiCAD
worksheet can be as big as you want it to be. You can pan
and zoom the Window within the full drawing space to obtain
the best view of the work you are doing.
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The Section/Elevation Window
Using the Section/Elevation Tool in the Toolbox, you can
generate any number of sections or elevations of your project,
which will appear in separate Windows. To open a section or
elevation, open the Section/Elevation workspace in the
Project Map by clicking the "+" symbol and then double click
the Section or Elevation you wish to view.

    

The Section/Elevation Window is interactively linked to
both the Floor Plan and 3D Windows. Elements selected in
this Window are recognized as walls, beams, columns, slabs,
roofs, windows, doors, lights and library parts. These
elements are fully editable using the same editing tools as you
use in the Floor Plan workspace.
You can also add drawing elements to this Window using the
2D drafting tools, place objects and text blocks on the
section/elevation and even copy and paste parts of the
Window to the floor plan for completing detailed working
documents.
Section/Elevation views are saved with your project model
file. It is also possible to save them as separate files in a
variety of drawing formats using the Save As... command
under the File menu.

The 3D Worksheet Window
The 3D Window is used for three-dimensional visualization
of the architectural project and as a project editing
environment. To open the 3D Window, go to the preset views
in the Project Map by clicking the "+" symbol next to 3D and
then double click either the perspective or axonometric
view.

   

Either the complete project or just the parts you select in plan
view will be displayed in the 3D Window. Block, Wireframe,
Hidden line and Shaded views are available in all types of
parallel and perspective projections. The 3D Window serves
a variety of functions:

- In your design phase, the 3D Window will serve as a
source for visual feedback of your work.

- It is an interactive Window, so you can move freely about
in the 3D environment both in Parallel and Perspective
projections.

- The elements in this Window, as in the Floor Plan and
Section/Elevation Windows, are completely editable.

- For PhotoRenderings, the 3D Window sets the view that
will be used to produce a final photorendering.

- For output to other applications, a 3D file can be exported
from the 3D Window.
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Tools & Palettes
Palettes can be customized to your preferences. Each Palette
can be shown or hidden separately from the Floating
Palettes hierarchical menu in the Window menu, and the
four main palettes (Toolbox, Info Box, Coordinate Box,
Control Box) can enabled or disabled together with the Show
Main Palettes Only command. The shapes of the main
palettes  can be customized with Options/Customize.

1. The Toolbox

The Toolbox is where you start in ArchiCAD. The Toolbox is
divided into five basic parts: Selection Tools, 3D Tools,
Notation Tools, 2D Tools and Visualization Tools.

Column

Marquee

Window

Corner Window

Object

Stair

Roof

Arrow

Wall

Beam

Door

Skylight

Lamp

Slab

Mesh Linear Dimension

Level Dimension

Text

Zone

Line

Polyline

Radial Dimension

Angle Dimension

Label

Fill

Circle

Spline Figure

Hotspot Section/Elevation

Detail Camera & QTVR

• Review the Tool Settings Dialogs: Each Tool has a
settings dialog associated with it. To review the dialogs for
each Tool, double-click the Tool.
Note: that each tool has various settings for Floor Plan,
Section, Model and Properties. The Wall Settings dialog is
typical of the basic settings for each of the 3D Tool settings.

The Object Settings dialog (shown below) is similar for all
library parts, which include windows, doors, lamps, objects
and stairs. This dialog contains a library part browser and a
system explorer tree to the left.
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2. Info Box

The Info Box displays the different control group parameters
of the currently active Tools on various panels. The items
displayed in the Info Box vary according to which ArchiCAD
Tool is currently selected.

The Info Box is a customizable palette. With this palette the
Infobox can be resized by the user manually by stretching the
bottom right corner of the palette. The bigger it is stretched,
the more information it shows.

• Review the Controls for Each Tool: In this exercise,
click each Tool in the Toolbox and observe how the Info
Box settings differ for each Tool selected.

 P-1, S-1, M-B

                           

3. Coordinate Box

The Coordinate Box shows you the precise location of the
ArchiCAD Cursor within both the Cartesian and the Polar
coordinates for your drawing. This allows the entering and
the viewing of very accurate numeric information through the
keyboard, in addition to or instead of the mouse.

• Cartesian and Polar Coordinates: Move the cursor to
the bottom right hand corner of the project so that the
cursor changes to a check mark. Notice that the all the
coordinates have a "0" value at this point. This point is
identified by an "X" on the screen and is called the
Project Origin.

You can toggle between Absolute and Relative coordinate
values during drafting or editing by clicking its Delta icons:

Absolute values  show the horizontal, vertical, radial and
angular distance of the cursor from the Project Origin or a
User Origin but never from an Edit Origin.

Relative values  show the horizontal, vertical, radial and
angular position of the cursor relative either to the Project
Origin, to a User Origin before any element is begun, or to an
Edit Origin once a drafting or editing process is under way.

• User Origin: Click the "X" button so that it is depressed
and click the upper left corner of the building. Notice that
the "X" has moved to this point and that the coordinates
have a "0" value at this new point. This is known as the
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User Origin and this button allows you to relocate the
origin anywhere in the Project.

• Skewed Grid: Turn on the Background grid by selecting
Grid Display from the Options menu. To change the grid
angle, click this button so that it is depressed and then click
once on the screen to define the start point of the grid and a
second point to define the angle of the skewed grid.

• The Grid Switch icon next to this Skewed Grid button
allows you to toggle between the normal and skewed grids.

• Grid Snap: This icon allows you to activate either of the
grids or turn off the snap feature altogether.

• Gravity: This icon allows the user to place elements
relative to existing Slabs, Roofs or Meshes. The Gravity
option can be turned off by selecting the "X" option.

• Elevation: The Elevation (z coordinate) field displays and
allows you to edit the height or elevation of elements
while the Elevation pop-up menu allows you to choose
whether the Elevation coordinate field will display
absolute or relative values.

4. Control Box

The Control Box gives you the ability to constrain the
drawing angle and cancel or confirm the current drawing
operation. It also allows you to group or ungroup elements,
choose extension line settings, select offsetting commands,
and provides active Tool specific help in the Command
Prompt area during different drawing steps.

• Relative Construction Methods: These construction
methods constrain the cursor to a defined angle or
distance during drafting or editing.

• Cursor Snap Variants: This option controls the way the
current position of the cursor is projected.

• Suspend Groups: This switch allows you to choose
between editing grouped elements together or on their
own.

• Magic Wand Tool: This tool traces the contours of existing
elements in order to create new elements of other types.

• Special Snap Point: Using this control allows the user to
use special definition controls to automatically generate
temporary snap points on different parts of edges.
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• Extended Control Box: The Prompt Box provides point-
by-point instructions during drafting or editing. To expand
the Control Box, click the button on the right side of the
palette.

Extended Control Box with Command Prompt
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Step 2: Understanding Objects and GDL
Overview

ArchiCAD is an object based program. This step introduces the concept of element types stored in outside files, including doors,
windows, lamps, labels, and general objects. These objects can be stored in an ArchiCAD Library, a project library or over the
Internet.

It also gives an overview of GDL (Graphic Description Language) and how it describes 3D solid objects like doors, windows,
furniture, structural elements, stairs, etc., and the 2D symbols representing them on the Floor Plan.

Process to Learn

• What are Objects
Types of Objects
Purpose of Objects

Object Parameters
Object Settings

• What is GDL
• The ArchiCAD Library

Starting the Step

Use your file from the previous step or open the file named Step-02.pln contained in the Step Files folder.
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Introduction
Library Parts are parametric prefabricated complex elements
created either by ArchiCAD or a third party application and
used as units in projects. When you start ArchiCAD for the
very first time, it searches for a Library under the name
ArchiCAD Library.
The icons in the Toolbox that reference ArchiCAD Libraries
are as follows:

                     

What to Do

1. The Concept of Parametrics

An ArchiCAD innovation, parametric object definition allows
a single stored object (i.e. window, door, light, stair or truss)
to represent dozens of similar objects by simply changing
their height, thickness, material and other custom parameters.
Each object can also be re-saved under another name
allowing you to quickly build up your own specific library.

 P-1, S-2, M-A, 1-2

To view an example of how parameters are used, double-
click on the Window Tool in the Toolbox. The dialog
contains various parameters that can create a window with
different forms, shapes, sizes and materials.
To make changes to the selected window, click in any of the
Parameters fields with your cursor and change the settings
(i.e., width, depth, length, height).

As you change the settings, view the preview window in top
view, side view, hidden line 3D view, shaded 3D view and as
a preview picture using the Display Mode buttons next to
the preview window.

You can choose between window objects using the thumbnail
previews in the browser at the left of the dialog or by
selecting a different window library from the system explorer
at the left of the dialog.

2. View an Object Library

To review the Object Library and how it is organized, double-
click the Object Tool in the Toolbox. The Object Settings
dialog will appear.
The Object Settings dialog (shown below) is similar for all
library part, which include windows, doors, lamps, objects
and stairs. The dialog contains a library part browser and a
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system explorer tree to the left. You can choose different
views of the object (top, side, 3D, etc.) by clicking the Display
Mode icons to the right of the object preview.

3. Review the Loaded Libraries

When ArchiCAD opens a project, it loads one or more
libraries from the local hard drive, network or the Internet. To
review which libraries are currently loaded, open Library
Manager from the File Menu.

• Local/LAN: The Local/LAN tab page allows you to
manage complete libraries and individual library parts
stored on local disks or on remote volumes connected to
your computer through a local area network.

To open the Library Manager, select the Library Manager
option from the File menu. Click on the Local/LAN tab and
the currently loaded ArchiCAD Libraries will appear in the
dialog.

   

• FTP and Web Objects:
- Using the FTP Sites tab page, you can add libraries and

single library parts stored on FTP servers.
- The Web Objects tab page allows you to download GDL

Objects from websites and add them to your local libraries.
Since you are currently working from your local hard drive,
the FTP Site and Web Object Settings will be empty since
no links have been established to an online site.

4. What is GDL

GDL (Graphic Description Language) is a parametric
programming language, similar to BASIC. It describes 3D solid
objects like doors, windows, furniture, structural elements,
stairs, etc., and the 2D symbols representing them on the floor
plan. These are called library parts.

Creating custom ArchiCAD objects does not require an
understanding of GDL. You can create custom library parts by
using the standard tools (Wall Tool for vertical elements, Slab
Tool for horizontal elements, Roof Tool for sloped elements,
etc.) and saving the custom design as a GDL Object by
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selecting "Save Selection As..." from the GDL Objects option
in the File menu as shown below.

If you need to add parameters such as material selection or
text input, you would then open the object and add GDL
parameters. You can learn more about this in the book Object
Making with ArchiCAD by David Nicholson-Cole. This book
is published by Graphisoft.
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Part Two: Project Setup

Step 3: Customizing the Drawing Environment
Overview

We can customize options such as project grid, snap grid, line types, pens, colors, pen weight, fills, composites, materials and
zones as well as Drawing Preferences to meet specific project needs and drawing requirements. This step teaches you how to
customize these options to your drawing needs.

Process to Learn

• Grids & Background

• Pens & Colors
• Line Types

• Fill Types
• Composites

• Preferences

Starting the Step

Open the file named Step-03.pln contained in the Step Files folder.
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Information
The document just opened will be used as the basis for much
of the remaining tutorial. Each step will build upon the model
to create a Virtual Building from which to derive plans,
sections, elevations, renderings, sun studies, virtual reality
scenes and more.
Using the controls in the Options Menu, you can customize
ArchiCAD to reflect your drawing standards and preferences.
We will use the following options in this exercise:

Grids & Background:

- The Grids & Background dialog allows you to define a
working grid configuration and establish a background
color for your workplace and grid lines.

Pens & Colors:

- ArchiCAD pen and color assignments are reviewed and
modified using the Pens & Colors… command. In
ArchiCAD, pens are simulated drawing instruments that
have a specific color and line weight.

Line Types:

- When you choose the Line Types command, a dialog box
appears allowing you to select, modify or delete the
standard line types (solid, dotted, dashed, etc.). You can
also define your own customized line or symbol line types.

Fill Types:

- Fills are geometric patterns that can display two faces:
bitmapped and vectorial, but only one of the two at one
time. You can set this option in the Display Options.

Composite Structures:

- Walls, Slabs and Roofs can have composite structures. In
ArchiCAD composite structures are composed of patterns
that represent the components that compose the
structure. These components can be assigned a size,
description and cost.

What to Do

1. Create a Project Grid

Open the Grids & Background dialog from the Options
menu. Set the Main Grid to 3' (914mm) and the Snap Grid to a
spacing of 1" (50mm).

2. Create a Custom Pen Color & Line Weight

Open the Pens & Colors... dialog from the Options menu.
Place your cursor on Pen #10 and double click the pen color
box or click the Edit Color button. The Edit Color dialog will
appear. Select the Yellow color and click OK.
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With Pen #10 still selected, place your cursor in the Pen
Weight text box and change the Pen Weight to 0.50 mm.
When finished click OK. You have now set a custom color
and line weight.

3. Create a Custom Line Type

This new Line Type will be used as a property line in Step 15.

 P-2, S-3, M-A

Open the Line Types... dialog from the Options Menu. Click
the New button, select the Dashed radio button and enter the
name Property Line. Click OK.

Select and drag the slider to the right to activate the three
columns as shown.

Now enter the numeric values as follows to create a property
line:

Column 1: Dash: .21 and Gap: .08
Column 2: Dash: .06 and Gap: .08

Column 3: Dash: .06 and Gap: .08
You can also manually change the line spacing by selecting
and dragging the flag.

When finished, click OK.

4. Create a Custom Fill Type

This new Fill Type will be used as a ceiling pattern in Step 14.
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Open the Fill Types... dialog from the Options Menu. Select
the "Ceramic Tile" pattern from the popup menu at the top
of the dialog (the patterns are listed in alphabetical order).

Click the New... button, click Duplicate and type in the new
name "Ceiling Grid". Click OK.

Now set the size to represent a Ceiling Grid pattern under
Edit Vectorial Pattern. Type in 4' (1200mm) for the length
and 1' (300mm) for the height.

Finally, change the Bitmap pattern (the pattern that appears
as a preview of Fill patterns in the Tools dialogs) to represent
the new pattern. To do this, click your cursor in the Bitmap
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Pattern box to turn the black dots ON. This will allow you to
create the pattern as shown below:

When finished click OK.

5. Create a Custom Composite Wall

This new Composite Structure will be used as a interior wall
type in Step 9.
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Open the Composites... dialog from the Options Menu.
Select "Stud Partition" from the popup menu as shown below.
Click OK.

Click the Insert button to add a new skin to the wall.

With the outer skin selected as shown, click the popup fill
pattern option in the Edit Selected Skin portion of the dialog
and select the Gypsum fill pattern. To change the width of
the Gypsum, click in the size box and enter 5/8" (25mm).

Now click and highlight the Wood Stud component of the
wall and click the ADD button to add a skin to the opposite
side of the wall. Click in the size box and enter 5/8" (25mm)
to set the size of the Gypsum. Click OK.

Note: Both Fill Types and Composite Structures can be
shown with either Bitmap or Vectorial patterns in the
Display Options. Bitmap Patterns are faster to display but
cannot be scaled, zoomed or rotated, while Vectorial
Patterns are slower to display but can be scaled, zoomed
and rotated.
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Step 4: Managing Project Information
Overview

This step is the foundation that will manage plans, sections, elevations, details, 3D information and final drawings for your
Virtual Building. ArchiCAD manages this information by using Layers, Layer Combinations and the Navigator.

In this step we will discuss how to set up your ArchiCAD model so that you can both manage the information and produce the
drawings.

Process to Learn

• Layers
• Layer Combinations

• Project Standards
• Navigator Palette

• Setting up Drawings
• Link to PlotMaker

Starting the Step

Use your file from the previous step or open the file named Step-04.pln contained in the Step Files folder.
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Introduction

1. Layer Settings

ArchiCAD layers are used to organize the elements in your
drawing for selective displays and quantity calculations. The
Layer Settings command displays the Layer Settings dialog
box, which allows you to define the layer settings for your
project.

2. Display Options

The Display Options command opens a dialog box where you
can customize the way the various construction elements are
displayed on the Floor Plan worksheet. As an example, you
can use this option to toggle between showing the door
swing or displaying a header for the ceiling plan.

3. Navigator

The Navigator palette is used to give an overview of the
project structure, providing instant access to stories,
sections, elevations, detail drawings, and 3D views lists.
Additionally, it is used to manage view options for typical
drawing types such as an architectural floor plan, site plan,
ceiling plan and other project drawings.

What to Do

1. Create Layers

Open the Layer Settings dialog under the Options Menu.
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This dialog contains building and notation layers provided by
ArchiCAD. To start this project we will add 3 new layers for
notation purposes. Using the Layer Settings dialog as shown,
create new layers by selecting New and typing the following
layer names:

Notes - Ceiling Plan
Notes - Floor Plan
Notes - Site Plan

  

2. Create Layer Combinations

Each Layer Combination is a "snapshot" of the state of all
Layers in the Project and can be called up at any time by
selecting its name from the Layers list. Layer Combinations
generally reflect the drawings that are to be produced (such
as a floor plan, ceiling plan and site plan).

 P-2, S-4, M-B
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Before adding new Layer Combinations, delete the current
Layer Combinations. To do this, select the each name and
click the Delete button as shown below:

To add a layer combination, click the New button and type
the Layer Combination names:

Ceiling Plan
Floor Plan
Site Plan

Once all the Layer Combination names are entered we must
choose which layers are to be active and which are inactive
using the Show or Hide buttons. Let’s start by selecting the
"Ceiling Plan" Layer Combination:

Then, click the Select All button and click the Hide button.
Now deselect all the layers by clicking the Deselect All
button. We are now ready to select which layers should be
active for the Ceiling Plan. To do this, select each of the
following active layers and click the Show button.

- Active Layers for the Ceiling Plan Layer Combination:
• Beams

• Columns
• Exterior Walls

• Fills
• Floors

• Interior Walls
• Lamps

• Notes - Ceiling Plan
• Roofs

When finished, click the Update button next to the Ceiling
Plan Layer Combination to make these changes permanent.

Now that the Ceiling Plan Layer Combination is finished,
repeat the above steps for the Floor Plan and Site Plan Layer
Combinations. The following layers are the active layers:

- Active Layers for the Floor Plan Layer Combination:

• Beams
• Columns

• Detail Markers
• Dimensioning

• Elevations
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• Exterior Walls
• Floors

• Furniture & Equipment
• Interior Walls

• Mark-Up
• Notes - Floor Plan

• Roofs
• Sections

• Stairs
• Zones

- Active Layers for the Site Plan Layer Combination:
• Columns

• Exterior Walls
• Floors

• Interior Walls
• Level Dimensioning
• Notes - Site Plan

• Roof
• Site & Landscaping

• Stairs
• Terrain

After having created the above layer combinations you can
choose among them under Option/Layers.

3. Name the Current Story

In this step we will create a name for the current story. Select
the Story Settings dialog from the Stories option in the
Options menu. Click in the Name text box and type "Ground
Floor" and click OK.

4. Create View Sets using the Navigator

Now that the project layers and layer combinations are set, we
must link these layer combinations to View Sets.

 P-2, S-4, M-C

Using the View Editor we will assign the drawing scale,
display options, layer combinations and drawing view. To edit
the View Sets, click the popup button on the upper left side of
the dialog and select the middle button to activate the View
Editor.

With the View Editor active, rename the "Untitled" View Set as
"Project Documents" by selecting Rename from the popup
commands at the right edge of the dialog.

Next, create new folders that reflect the Drawings to be
produced. To do this, click the New Folder button circled
below and click the folder to rename it as "Drawings". With
the Drawings folder highlighted, click the New Folder
button again and rename it as "Ceiling Plan".
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Highlight the Drawings folder and repeat this step to create
two additional folders named "Floor Plan" and "Site Plan"
as shown below.

To set the order of the folders simply click and drag the
folder as shown below:

5. Assign View Settings and Storing Options

The final step is to assign the scale, display options and layer
combination to each Drawing Type created.
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To configure these Drawing Types, set the View Settings and
Storing Options as shown below:

• Assign the Floor Plan Settings/Options:
- Click and highlight "1. Ground Floor" (0. Ground Floor -

Metric) within the Stories section of the Project Map.

Assign the "Floor Plan" layer combination by clicking the
Layer Combination popup button in the View Settings &
Storing Options at the lower part of the Navigator palette.

     

- Now that we have changed the View Settings and Storing
Options for the Ground Floor, we must assign these
settings to the Floor Plan folder. To do this, drag and
drop the story "1. Ground Floor" (0. Ground Floor -
Metric) into the Floor Plan folder as shown below.

  

• Assign the Ceiling Plan Settings/Options:
- Click and highlight "1. Ground Floor" (0. Ground Floor -

Metric) within the Stories section of the Project Map.
Assign the "Ceiling Plan" layer combination by clicking the
Layer Combination popup button in the View Settings &
Storing Options at the lower part of the Navigator palette.

     

- Next, open the Display Options dialog from the Options
menu. Within the dialog, set the "Doors & Windows" view
option to "Reflected Ceiling", the "Construction Fills" view
option to "Empty" and the "Polygon Fills" view option to
"Vectorial Hatching". Click OK when finished.
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- Now that we have changed the View Settings and Storing
Options for the Ground Floor we must assign these
settings to the Ceiling Plan folder. To do this, drag and
drop the story "1. Ground Floor" (0. Ground Floor -
Metric) into the Ceiling Plan folder as shown below.

  
• Assign the Site Plan Settings/Options:
- Click and highlight "1. Ground Floor" (0. Ground Floor -

Metric) within the Stories section of the Project Map.
Assign the "Site Plan" layer combination by clicking the
Layer Combination popup button in the View Settings &
Storing Options at the lower part of the Navigator palette.

- Next, open the Display Options dialog from the Options
menu. Set the "Doors & Windows" view option to "Show
on Plan" and the "Construction Fills" view option to
"Uniform Solid". Click OK when finished.

- Now change the scale for the Site Plan by clicking the
Scale popup button in the View Settings & Storing Options
at the lower part of the Navigator palette. Change the scale
to 1"=20'-0" (1:200 mm).

- Now that we have changed the View Settings and Stored
Options for the Ground Floor, we must assign these
settings to the Site Plan folder. To do this, drag and drop
the story "1. Ground Floor" (0. Ground Floor - Metric) into
the Site Plan folder as shown below.
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6. Turn Off the View Editor

When you are finished with the above steps, restore the
Navigator to its original setup by turning off the View Editor.
To do this, click the popup button on the upper left side of
the dialog and select the left button to activate the Navigator.
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Part Three: Creating the Virtual Building

Step 5: Establishing the Base Building Layout
Overview

This step will teach you how to use the Slab Tool for creating a building slab and external paving. You will explore ways of
manipulating slab shapes and slab openings. You will also learn how to construct linear and curved walls using the Wall Tool
in both the Floor Plan Window and the 3D Window.

Process to Learn

• Creating a Slab

• Slab Materials
• Editing a Slab

• Creating Linear Walls
• Creating Curved Walls

• Wall Materials
• Working in the 3D Window

Starting the Step

Use your file from the previous step or open the file named Step-05.pln contained in the Step Files folder.
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Introduction
When you create a Wall in ArchiCAD, you create the outline
and hatching of a Wall in 2D, and a solid Wall body in 3D.
Because Walls are such important elements of your Project,
they form special relationships with other ArchiCAD
elements:

* Other Walls: Automatic L and T intersections are formed
between Walls. Overlapping vertical edge segments for
tangential Walls.

* Columns: Automatic Wall-Column connections, optional
Wall wrapping around columns.

* Beams: When a Beam crosses a Wall, the element of lower
priority is cut in 3D.

* Doors and Windows: A Wall is the only placeholder of
these elements. They become part of the Wall.

* Slabs: Overlapping Wall and Slab edges are eliminated in
3D: facades will be clean on elevations and other 3D
views.

* Roofs: Walls can be trimmed to Roofs.
Slabs are the basic horizontal building blocks in ArchiCAD.
Slabs are drawn either on the Floor Plan or in the 3D Window,
allowing them to accommodate any design. Existing Slabs are
easily modified on the Floor Plan and in the 3D Window or
through the Slab Settings dialog box.

What to Do

1. Set the View Set to "Floor Plan" using the Navigator

To set the View Set to the Floor Plan, click the View Set tab in
the Navigator palette and double-click the Ground Floor in
the Floor Plan view set:

2. Construct a Floor Slab

The first step is to draw the ground floor slab of the building,
which will be 30 by 18 feet (10 by 6 meters) in plan. Use the
pre-set 3 square foot (1 meter square) planning grid to help
you construct the slab, by easily snapping to its intersection
points.

Hint: The different grid snap options can be switched on
and off using the control button on the Coordinate Box or
the menu items from the Options menu. When any of the
snap options is switched on, the cursor moves from one
grid intersection to another.
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To draw the slab, do the following:

- Switch on the grid snap (select the third icon in the popup
palette from the grid snap options in the Coordinate Box).

- Select the Slab tool  in the Toolbox.
- Select the rectangular geometry method from the Info Box.

- Click on the origin indicated by the black X on the Floor
Plan.

- Click a second time to finish the slab covering 10 grid
squares horizontally and 6 vertically.
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Hint: To change the view of the plan, choose the Zoom
in/Zoom out/Pan or Fit in Window commands from the
Display menu and either double-click on the plan or draw
a marquee to define the extent of the magnification.
Alternatively, use the magnifying glass/palm icons from
the bottom of the window.

3. Create Linear Walls

At any time, you can see a three dimensional view of what is
on the Floor Plan by opening the 3D Window by using the
Window menu/3D Window command.

 P-3, S-5, M-B

Now place walls around the sides of the slab here in the 3D
Window. Use the magic wand feature to trace the perimeter of
the slab and automatically place walls on it.
To place walls on the sides of the slab:

- Select the Wall tool  in the Toolbox.
- Select the Magic Wand icon in the Control Box.

- Click on the front edge of the slab with the cursor (the
Magic Wand icon will change to a wand with a loop
indicating that you are snapping to a line).

- Click on one of the top corner points of the slab to finish
placing the walls.

Hint: The 3D Navigation Palette helps you navigate
around in the 3D window. The Editing-Motion buttons are
available depending on the type of the view (perspective/
axonometric); the Motion Mode buttons allow for
changing between the view types. To navigate in an
axonometric view select the fourth button under Editing-
Motion (as shown) and click outside the rectangle in the
3D Window. We will discuss more about 3D Navigation
and options in Step 06.

Go back to the Floor Plan (Window menu/Floor Plan).
Notice that the walls have appeared on the plan.
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4. Construct Curved Walls

Now construct a curved block wall to the north of the
building for the entrance enclosure.
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To do this, first change the wall type to a block wall:
- Double-click on the Wall tool in the Toolbox to bring up

the Wall Settings dialog box.
- Change the thickness of the wall from 1' to 1'-2" (250 to

300 mm).

- Change the “Face Brick” hatching type to “Masonry Block”
under “Floor Plan and Section Attributes” (the hatches are
listed in alphabetical order).

- Change the “White-Brick” material to “Stone Block” for the
internal and external sides and to “Stone Block Coping” for
the edges of the wall under “Model Attributes”.

- Click OK.

Place the curved wall shown in the picture below. The
curvature will be defined by 3 points, all of which will be grid
intersection points.

Hint: When drawing the line of the wall, after a first click a
heavy black line follows the cursor like a rubberband. This
"rubberband line" is the reference line for the wall. The
reference line is used to connect walls smoothly and helps
locate the walls with the cursor.

To draw the curved wall:
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- Choose the relevant curved wall icon (2nd icon in the 2nd

row) from the geometry methods in the Info Box.

- Change the construction method as shown in the picture.

- Click on the grid intersection points in the order shown in
the picture (the third and the fourth clicks are on the same
point).

Hint: You can get instant step-by-step instructions of the
drafting and editing procedures in the maximized state of
the Control Box. Following them eases the drawing
procedure and reduces the number of errors.

It is easy to modify the length of this curved wall, for example
by stretching both ends of the wall:

- Switch off grid snap. (Select the first icon from the grid snap
options in the Coordinate Box as shown in the picture.)

- Select the wall (Select the Arrow tool  and click on a
side or a corner of the wall to highlight it. The appearing
black dots around the wall confirm it has been selected.)

- Choose Edit menu and Stretch.
- Click on the hotspot (on the side of the wall’s reference

line) on the right end of the curved wall and make it
approximately half a grid longer as shown in the picture
(the cursor will change from an empty pencil symbol to a
black one when snapping to a hotspot).

- Repeat for the other end of the wall.

Hint: To select something on the floor plan, use the mouse
cursor. If the Arrow tool is active, simply click on one of the
element’s points. (To add/remove more elements to the
selection hold down the Shift button while selecting them.)
When another tool is active, press the Shift button to
activate the selection method.

5. Place Structural Columns

Next, place four columns to create a veranda on the south
side of the building.
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The first and the last column will align with the two side walls
(place them on a grid intersection); they will be placed at
equal intervals and run parallel to the front wall. Place the first
column and then replicate it for the rest.
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To place the first column:
- Switch on the grid snap.

- Select the Column tool  in the Toolbox.
- Click on the grid intersection point two grid spaces below

the bottom left corner of the house (point no. 1).

Notice that the column has been placed on the grid
intersection point on the Floor Plan.
The next step is to replicate it parallel to the front wall:

- Switch off the grid snap.
- Select the column.

- Select the Multiply command from Edit/Multiply.
- Enter 3 as the number of copies, choose the Distribute

method and hit OK.

- Click on one of the selection dots on the right side of the
column and drag the rubber line horizontally, toward the
right end of the building.

- Hold down the Shift key. You can see you are now
constraining the horizontal direction, and the columns will
be placed parallel to the side of the building.

- Position the cursor over the bottom right corner of the
building (your cursor will change to a check mark
indicating, that it will snap to a hotspot) so that the last
copy will be aligned with the end of the building.

- Click to finish the Multiply command.
Hint: The mouse constraints help draw elements in
specific relationship to existing elements and pre-set



43

Step 5: Establishing the Base Building Layout

Graphisoft ArchiCAD Step by Step Tutorial

directions. They are similar to traditional rulers and
triangles.

Two Mouse Constraint mechanisms are available:
Coordinate Constraints are used to lock any of the
Coordinate Box parameters and
Angle Pairs are used to lock the cursor at a particular
drawing angle.

These techniques facilitate the use of all the 2D/3D
drafting tools.

Hint: The Intelligent Cursor helps you identify special
points (end, corner points, edges, etc.) and points of
geometric relationships of elements (perpendicular,
tangential, crossings) within the building and to show that
special tools (magic wand, eyedropper, etc.) are effective
at the moment.

Click outside the building to deselect the column and go to
the 3D Window to see the result in axonometry.

6. Create the External Paving

Now return to the Floor Plan to design the external paving
around the house.
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It will be of a timber decking construction, so the next step is
to change the slab height, hatching type and materials. After
that, place a rectangular slab around the building; lastly cut a
hole into the slab for the footprint of the building.

To change the slab settings:
- Double click on the Slab tool in the Toolbox.

- Enter 6" (150 mm) as the thickness of the slab.
- Change the hatching type in the “Section Attributes” to

“Dot and Dashed”.

- Change the top and the side materials in the “Model
Attributes” to “Timber Boarding External” and the bottom
to “Surface Concrete”.

- Click OK.
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To place the slab:
- Switch on the grid snap.

- Click to the grid intersection at point no. 1 to start drawing
the rectangular slab.

- Click to the grid intersection at point no. 2 to finish
drawing the slab.

To cut a hole in the slab:
- Select the slab.

- Make sure the Slab tool is active in the Toolbox.
- Click to the grid intersection at point no. 3 to start drawing

the rectangular hole of the slab.

- Click to the grid intersection at point no. 4 to finish
drawing the hole of the slab.

- Click outside the slab to deselect it.
Check the result in the 3D Window.
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Step 6: Viewing the Building in 3D
Overview

The underlying principle of ArchiCAD is that a building is created on the computer not as a set of lines, but as a Virtual
Building complete with 3D information. This step introduces how to view and edit the virtual model environment.

You begin the lesson using the two basic methods of the 3D Settings: parallel projections and perspective settings.

Process to Learn

• Navigator Palette

• Navigator 3D Preview
• 3D Projection Settings

• 3D Window
Navigating in 3D

• 3D View Types
Perspective View

Parallel Projections

Starting the Step

Use your file from the previous step or open the file named Step-06.pln contained in the Step Files folder.
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Introduction
3D Window: The 3D Window is used both for three-
dimensional visualization of an architectural project and for
refining the design directly in 3D. It is directly linked to the
Floor Plan Worksheet and to the Section/Elevation Windows.
You can display either the complete project or just the
selected parts.

• In the design phase, the 3D Window will serve as a source
of visual feedback for your work in 2D and for constructing
and modifying building components directly in 3D.

• In the production phase of your project, accurate 3D
images optimized for plotter output are also generated in
this Window.

3D Projections: The 3D Window can display two types of
three-dimensional views: Parallel Projection and Perspective.
To access these two view options, you can choose from
several methods:

• Navigator Palette & Preview
• 3D Projections Dialog
• 3D Navigation Palette
• Camera Tool

What to Do

1. Navigator Palette & Preview

The Navigator Preview provides 3D Perspective and 3D
Axonometric previews. In the 3D Perspective view you can
manipulate the camera directly. In the 3D Axonometric views,
a Small house popup button at the bottom of the palette lets
you choose from predefined projections.
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• Select Generic Perspective: To set the 3D Window to a
perspective view, click the Project Map tab in the Navigator
palette, click 3D and double-click the Generic Perspective.

 

• Navigate Using the Navigator Preview Camera: In the
bottom left corner of the screen is the Navigator Preview
palette. Click the camera location point (#1) and drag
your cursor; the 3D Window will change views based
upon the position of the camera. Now select the camera
target point and drag your cursor (# 2). You can also
interactively change the zoom by selecting the slider (# 3).

• Select Generic Axonometry: To set the 3D Window to
an axonometric view, click the Project Map tab in the
Navigator palette, click 3D and double-click the Generic
Axonometry option.

   

• Navigate Using the Navigator Preview Camera: Select
the camera in the Navigator Preview. You can navigate the
3D window by moving the camera symbolizing the
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projection direction. At the bottom of the palette, the
popup button lets you choose from predefined
projections.

2. 3D Projection Settings

There are two main dialog boxes for 3D views: Parallel
Projection Settings and Perspective Settings. These dialog
boxes offer more options for defining custom views such as
sun position, sun location camera angle and target distance.
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• Parallel Settings: Choose the 3D Projection Settings
dialog under the Image Menu. This dialog allows you to set
views based upon numeric entries and sun position as well
as from pre-set views. To change your viewpoint, drag the
camera around the house and click OK. To change the sun
position, drag the sun around the house and click OK. To
set a specific location for the sun, click the More Sun button.

• Perspective Settings: Open the 3D Projection Settings
dialog, under the Image Menu. Click the Perspective
button at the top of the dialog and use the Perspective
Settings dialog. To try different perspective views, drag
the end of the camera and/or the focal point to a different
position and click OK.

3. Interactive 3D Window

The 3D Window allows for interactive 3D motion. Interactive
navigation through your model is available in both Parallel
and Perspective modes. The following steps will guide you
through various options for determining position and
movement in the 3D virtual environment.
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• Navigate the 3D Window - Parallel Projections: Go to
the Image Menu, select 3D Projection Settings and
create a Parallel Projection.

Click on the Model Axis button  and then select the Turn
button  in the 3D Navigation Palette.

Place the Cursor on the 3D Window and click and drag the
mouse slowly to the right. Drag the mouse to the left. Now try
upward and downward. You are rotating the model about its
axes.

Click on the Target Lock button  and then repeat the
different rolling procedures. Notice the difference in the way
the model rolls.
Click the Frontal View button  and then click on a surface
you want to view in elevation. The view resets to the
elevation of that element.

• Navigate the 3D Window - Perspective Projections:
Go to the Image Menu, select 3D Projection Settings
and create a Perspective Projection.

Click on the Camera button  and then on the Walk
button  in the 3D Navigation Palette.
Place the Cursor on the 3D Window with the Cursor Arrow
facing up and drag the mouse slowly upward to walk
forward; drag the mouse down to walk backward, and to the
right or left to walk to the side.

Try using the Turn button  and the Lateral Move Tool
. Notice the difference in movement.

Click on the Target Lock button  and repeat the previous
Tool selections and maneuvers.

Select the View Cone Angle to slide the button right or left to
change the view cone angle, which affects the current zoom.
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Step 7: Working with Stories
Overview

Stories provide a “physical” separation of elements according to their vertical level. Each story has a unique Floor Plan window
in which you place elements – just as architects use separate plans for stories of a building.

This exercise will demonstrate how stories are created in ArchiCAD and how elements are copied between stories.

Process to Learn

• Creating a New Story

• Copying Elements Between Stories
• Viewing 3D Vectorial Hatching

• Slab Settings
• Constructing the Slab

• Updating View Sets

Starting the Step

Use your file from the previous step or open the file named Step-07.pln contained in the Step Files folder.
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Information
Choosing the Stories menu item opens a submenu with
commands that allow you to:

• Define the vertical structure of your design, story by story

• Navigate between stories by determining which story is
currently displayed

• Display a Ghost Story
• Move elements and items between them using a special

Cut/Copy and Paste function
All Story functions are controlled through the Stories
submenu or through the Project Map section of the
Navigator palette. The Stories and their elevation value
defined in the Story Settings dialog box are displayed at the
bottom of the submenu. The current Story is shown three
different ways within the project model:

• With a Checkmark in the submenu listing

• As the name appears in the title bar of the Floor Plan
Window

• Highlighted in the Project Map section of the Navigator
Palette

What to Do
The next step is to define the story structure for the
Showroom building.
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Two stories are required; the ground floor which we have
worked on so far, and an upper Gallery. Open the Story
Settings dialog box to create the stories, define their heights
and copy and paste elements between them.

1. Create the Gallery Story

- Go back to the Floor Plan.
- Select Options/Stories/Story Settings to bring up the

Story Settings dialog box.

- Click to highlight “Ground Floor”.
- Click Insert above to create a story above it.

- Enter “Gallery” as the name for story no. 2 (metric 1) and
change its “Height to Next” value to 9'-6" (3000 mm).

The next step is to copy all the walls from the ground floor
and paste them into the gallery:

- Highlight the Ground Floor story and Click on the Copy
All button.

- Highlight the Gallery story.

- Unclick the column and the slab icon from the icons
below (so that they will not be included among the items
that will be pasted to the Gallery level).

- Click on Paste Selected Types and Click OK.

You are now on the Gallery story. As you can see, the walls
have been copied from the ground floor. (The name of the
story is written in the window’s title bar after the file name.)

2. Add the Gallery to the Project Documents View Set

Using the View Editor, as we did in Step 4, we will assign the
drawing scale, display options, layer combinations and
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drawing view for the three drawing types: Ceiling Plan, Floor
Plan and Site Plan.
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To edit the View Sets, click the popup button on the upper
left side of the Navigator dialog and select the middle button
to activate the View Editor.

• Assign the Ceiling Plan Settings/Options to the
Gallery:

- Select and double click the "1. Ground Floor" (0. Ground
Floor - Metric) in the Ceiling Plan section of the View Sets.
This will set the view to the Ceiling Plan layer
combination, scale and display options that were set in
Step 4.

- Now that we have set the View Settings and Stored
Options to the Ceiling Plan drawing type, drag and drop
the story "2. Gallery" (1. Gallery - Metric) into the Ceiling
Plan folder as shown below.

• Assign the Floor Plan Settings/Options to the
Gallery:

- Select and double click the "1. Ground Floor" (0. Ground
Floor - Metric) within the Floor Plan section of the View
Sets. This will set the view to the Floor Plan layer
combination, scale and display options that were set in
Step 4.

- Now that we have set the View Settings and Stored
Options to the Floor Plan drawing type, drag and drop the
story "2. Gallery" (1. Gallery - Metric) into the Floor Plan
folder as shown below.

3. Turn Off the View Editor

When you are finished with the above steps, restore the
Navigator to its original setup by turning off the View Editor.
To do this, click the popup button on the upper left side of
the dialog and select the left button to activate the Navigator.
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4. Open the 3D Window again to check progress

Hint: If the view is not as shown below, go to the Image
menu and select the 3D Projections option. If Parallel
Projections is not active, click the Parallel Projections
button and select an Axonometric preset view.

       

The texture of the construction elements can be made visible
in the 3D window. To see how the building looks with the
mortar joints and the floor boarding:

- Select Image menu/ 3D Window Settings.
- Switch on the Vectorial 3D Hatching under the effects

menu item.

5. Construct the Slab

To construct the slab of the gallery, return to the Floor Plan. It
will be of a light timber joist construction, different from that
used for the ground floor slab, so first the settings for the Slab
tool need to be changed.
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To change the slab settings:
- Double-click on the Slab tool in the Toolbox.

- Change the thickness of the slab to 8" (200 mm).
- Change the hatching type to “Empty fill” under “Section

Attributes”.
- Change the bottom and the side materials in the “Model

Attributes” to “Surface White” and the top material to
“Timber Boarding Internal”.

- Click OK.

Now everything is set for placing the gallery slab. The slab
will only span to half the depth of the building, leaving a void
so that one can look down from the gallery to the exhibition
space on the ground floor.

To place the slab:

- Switch off the grid snap.
- Select the Slab tool in the Toolbox.

- Click on the inside corner point of the top left wall corner
to start drawing the slab (point no. 1 in the picture).

- Move the cursor over the inside line of the east side wall to
bring up a snap point in the middle of the wall (above
point no. 2 the cursor will change from an empty pencil to
a pencil with a line inside it to indicate it is snapping to a
line).
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- Click on the snap point in the middle of the wall to finish
the slab (at point no. 2 the cursor will change from a
pencil with a line inside it to a black pencil to indicate it is
snapping to a point).
Hint: Special snap points help you to find special points
on the drawings. These snap points can be predefined
divisions/distances of lines/arcs, center point of arcs, and
parallel and perpendicular locations from elements.
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Step 8: Completing the Building Envelope
Overview

In this Step, you will use the Roof Tool to build a roof. This exercise will also demonstrate how to trim walls and columns to a
roof, and how to use the Ghost Story.

Process to Learn

• Roof Tool

• Using the Ghost Story Feature

• Constructing a Roof

Viewing a Roof in the 3D Window
• Trim Walls and Columns to Roof

Starting the Step

Use your file from the previous step or open the file named Step-08.pln contained in the Step Files folder.
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Information
ArchiCAD's sophisticated Roof Tool has extremely flexible
characteristics. In addition to its normal use in creating roofs,
it can be used to create abstract 3D shapes. You can create
three basic roof types by using the Roof tool:

- Sloped Roofs

- Dome-Shaped Roofs
- Barrel-Vaulted Roofs

What to Do
This section explains how to put a roof over the building. It
will be a semi-pitched roof with sufficient headroom over the
floor of the gallery, and will have a wide overhang supported
by columns to create a south-facing veranda at the front.

1. Roof and Ghost Story Setup

To construct the roof on the gallery level it is necessary to see
the columns below on the ground floor.
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Contents of remote stories can be made visible on the active
story by using the “Ghost Story” feature. To switch on the
Ghost Story, select Options/Stories/Show Ghost Story. Now
the content of the Ground Floor is visible a light yellow color
on the plan of the Gallery. The elements of the Ghost story
cannot be edited, but they can be used as snap points in
constructing new elements.
Before starting, open the Roof Settings dialog box by
double-clicking on the Roof tool  in the Toolbox.
The angle of the roof will be 20 degrees, its thickness 8” (200
mm) and its pivot line will be at 12'-6’ (3800 mm) above the
project 0 level (2'-7” (800 mm) from the Gallery level), as
shown in the picture. Click OK.

2. Roof Construction

To construct a roof, first define its pivot line (which is the
intersection line of the roof plane and the horizontal plane at
the height defined in the dialog). Then define from which side
of the pivot line the roof will slope upward (at the angle
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defined in the dialog box) and lastly draw the outline of the
roof (which is its projection to the horizontal plane).

To start constructing the roof:

- Switch on the grid snap.
- Select the rectangular geometry method in the Info Box.

- Click on the external corner point of the bottom left wall
corner (point no. 1) to start the pivot line.

- Click on the external corner point of the bottom right wall
corner (point no. 2) to finish drawing the pivot line.

- Click above the pivot line with the eye icon (point no. 3 to
define the uphill slope direction of the roof.

- Click on the grid intersection point at point no. 4 to start
drawing the outline of the roof.

- Click on the grid intersection point at point no. 5 to finish
drawing the outline of the roof.

Look at the roof in the 3D Window.

3. Trim the Walls and Columns to the Roof

Now you can trim the walls and the columns to the roof:

- Select the roof in the 3D Window (click on it with the
Arrow tool).

- Select the Edit/Trim to Roof menu point.

- Click Trim in the dialog box.
The columns and walls have now been trimmed to the
underside of the roof. Finally, return to the Floor Plan.
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Step 9: Developing the Design
Overview

Now that the building envelope is under way, we need to create sections and elevations of the building, and add interior walls,
create additional roofs and update the project View Sets.

Process to Learn

• Section/Elevation Tool
• Level Dimension Tool

• Update View Set
• Adding Interior Walls

• Creating a Flat Roof

Starting the Step

Use your file from the previous step or open the file named Step-09.pln contained in the Step Files folder.
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Information
The Section/Elevation Tool is used to generate elevations
and sections from the model by placing standard section/
elevation symbols on the Floor Plan with optional
breakpoints, including markers with identifiers and a section
line.
Every section/elevation symbol is an active link to the
model, meaning that when you change an element in section
or elevation it will automatically update all other views.

What to Do

1. Cut a Cross Section Through the Building

Simply place the section/elevation line on the Floor Plan and
ArchiCAD will generate the sectional/elevational view of the
building.

 P-3, S-9, M-A

Any modifications to the model in the Section/Elevation
Window will be updated automatically in all other views of
the building.

To place a section through the building:

- Switch on the grid snap (to help you quickly define the
section line location).

- Go down to the ground Floor Plan (Options/Stories/
Ground Floor).

- Select the Section tool  in the Toolbox.
- Click to point 1 as shown to start drawing the section line

on the Floor Plan.

- Double-click on points 2-3 as shown to finish drawing the
section line.

- Click to the right of the section line (point 4 as shown)
with the eye icon to determine which direction the section
will face.

After placing the section, open the section window (Window/
Sections/Elevations/’A/1 Section’/Model), and ArchiCAD will
generate the section of the model automatically.

Finally, add the A/1 Section as a new drawing to the
Project Documents View Set. This will allow us to access the
section as a drawing in PlotMaker.
To do this, click the View Sets tab in the Navigator palette,
select the Drawings folder so that it is highlighted and choose
Create New Folder from the popup menu. Name the new
folder "Sections". This is where our project sections will be
stored. If you want to move the Sections folder so that it is
organized alphabetically, click to highlight the folder, then
drag it to the desired location.
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With the section folder selected, choose "Save Current View"
from the popup menu. Use the defaults and click "Save".

     

2. Create the North and West Elevation

The elements can be shown with or without textures. Sun
shadows can be cast on them in the elevation windows.
To place the elevations:

- Double-click on the Section/Elevation tool in the
Toolbox to bring up the Section/Elevation Settings dialog
box.

- Enter “Elevation” to the Name field.
- Enter E/1 as the Reference ID.

- Check the Vectorial 3D Hatching and the Vectorial Sun
Shadows options under the Model Effects.

- Place the elevations as shown (ArchiCAD will number
them automatically).

- Switch off the grid snap.
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Next, open the west elevation and place some elevation
dimensions on it.

- Open up E1 Elevation (Window/Sections/Elevations/’E/1
Elevation’/Model).

- Select the Dimension tool  in the Toolbox.

- Select the height dimensioning icon from the popup menu
under the construction methods in the Info Box.

- Select the multiple height dimensioning icon from the
popup menu under the geometry methods in the Info Box.

- Click to the points (1-2-3) as shown in the picture to
dimension.

- Double-click anywhere (e.g. to points 4-5). The Hammer
cursor will come up.

- Click with the Hammer cursor to place the chain of
dimensions on the section (point 6).

Finally, add the E1 Elevation as a new drawing to the
Project Documents View Set. This will allow us to access the
section as a drawing in PlotMaker.

To do this, click the View Sets tab in the Navigator palette,
select the Drawings folder and choose Create New Folder
from the popup menu. Name the new folder "Elevations". If
you want to organize the Elevations alphabetically, click to
highlight the folder then drag it to the desired location.

With the Elevation folder selected, choose "Save Current
View". Use the defaults and click "Save".
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Open the E2 Elevation for another view of the building and
repeat the same steps to save it to the View Set as shown
above.

3. Add Exterior and Interior Walls

For the entrance, draw the same type of wall as the external
walls.
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In ArchiCAD you can easily pick up an element’s
characteristics and transfer them into the Toolbox (to start
drawing a new element with the same settings) or to other
elements in the project. Let’s pick up the settings of the
external walls:

- Select the Wall tool in the Toolbox.
- Hold down the Alt key (the cursor will change to an

Eyedropper tool) while clicking on a side of one of the
straight walls (a beep notifies the action).

Now the settings are correct for the brick wall, and only the
height value needs to be changed. Double-click on the Wall
tool in the Toolbox and change the height value to 8'-6"( 2700
mm).

Draw the front and the back wall of the entrance enclosure
with the help of the grid snap.

- Switch on the grid snap.

- Select the single wall geometry method and the
construction method as below.

- Click to the grid intersection point 1 to start drawing the
wall.

- Click to the grid intersection point 2 to finish the wall.

In the same way draw the back wall starting from point 3 and
finishing at point 4. Just make sure to choose the correct
construction method to place the wall with its reference line
on the outside.
Rebuild the floor plan view (Choose Window/ Rebuild) to get
a neat wall cross-section (optional).

Hint: The Redraw command (Display/Redraw) will
remove all temporary screen display graphics remaining
from transformations and deletions during construction.
The Rebuild command (Display/Rebuild) starts a more
thorough screen update - it will also refresh the wall
intersections and draw them correctly.

The next step is to draw some interior partitions. Open the
Wall Settings dialog box and select the composite wall, Stud
Partition, you created in Step 3.
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Change the layer from “Exterior walls” to “Interior walls” and
set the material of the wall to "Surface-White".

Draw the partition in the middle of the space as shown.

Hint: ArchiCAD layers are used to organize the elements
in your project for selective displays and quantity
calculations. You can easily change the layer settings
(show/hide, lock/unlock layers and create different layer
combinations) from the Options/Layers/Layer Settings
pull-down menu.

Now draw the partition of the future toilet at 3 feet (1000 mm)
wide; enter the coordinate values manually:

- Switch off the grid snap.
- Position the cursor over the right corner point of the wall

junction as shown (point 1).
- Type in x from the keyboard (Note the x coordinate is

highlighted).

- Type in “3 +” (or “1000 +” in mm) from the keyboard and
hit the Enter key. Note you are now drawing a wall from
point 2 (3’ (1000 mm) to the right of point 1).

- Use the shift key to draw a vertical wall and click on the
internal side of the curved wall to finish the wall (point 3).

4. Create a Flat Roof

Go up to the floor plan of the Gallery and place a flat roof
over the entrance to finish the building envelope.
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Open up the Slab Settings dialog box and set the thickness of
the slab to 1' (300 mm), the top material to “Timber boarding
External”, the side material to “White Brick” and the bottom
material to “Surface-White”.
To draw the slab over the entrance:

- Select the polygonal geometry method.
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Click on the external corner points of the front and the back
wall (points 1, 2, 3, 4, 5) to place a rectangular slab as shown
in the picture.
Now modify the northern edge of the slab to align it with the
curved wall:

- Select the slab.
- Make sure the Slab tool is active in the Toolbox.

- Hold down the mouse button over the edge of the slab
(between points 2 and 3) and select the second icon as
shown from the pet palette (as shown).

- Pull the edge of the slab over the curve of the wall to align.

Now check the progress in the cross section. Open the
Section A/1 window (Window/Sections/Elevations/’A/1
Section’/Model). The curved wall will serve as a parapet wall
to the balcony so lower it to 4’ (1200 mm) height:

- Switch off the grid snap.
- Select the top part of the curved wall.

- Double-click the Wall tool in the Toolbox to bring up the
Wall Settings dialog box.

- Enter 4’ (1200 mm) as the height value instead of 9’6”
(3000 mm).

- Click OK.
Open the elevations to check how the modification affects the
facades. Notice how the elevations have been updated with
the dimensions.
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Step 10: Working with Doors, Windows and Skylights
Overview

In Step 10, you will learn about the Door and Window Tools, which create realistic architectural openings in wall elements by
inserting special library parts with editable parameters.

Additionally, we will place a Skylight into the roof. In ArchiCAD, Skylights are objects that recognize a roof element and
automatically cut the opening within the roof structure.

Process to Learn

• Parameters for Doors/Windows
• Using the ArchiCAD Library

• Placing a Door/Window
• Viewing a Door/Window

• Editing Doors/Windows
• Creating Dimensions

• Placing a Skylight

Starting the Step

Use your file from the previous step or open the file named Step-10.pln contained in the Step Files folder.
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Introduction
Both Windows and Doors are objects, meaning that they are
stored in libraries of objects that can be used on many
Projects. Library Parts comprise a 2D Symbol and a 3D
description in GDL (Geometric Description Language), as well
as some optional information such as an additional 2D
description, a user interface script or a component definition.

         

Windows and Doors can be added to an ArchiCAD Project
only by placing them into an existing wall. They cannot be
independently placed into a Project. Once a Window or Door
has been placed in a Wall, it becomes an integral part of that
wall and stays with the wall when it is moved or stretched.

Doors and Windows cut real, see-through openings into the
wall, so that 3D visualizations are more accurate and lifelike.

What to Do
It is time now to develop the design further by adding
openings into the building. ArchiCAD’s door and window
objects are parametric library parts; by changing their
parameters, their properties change. The parameters can be
modified in the Object Settings dialog box.

1. Add an Entrance Door

Now return to the Ground floor plan and start placing doors
to achieve the layout as shown below.
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Double-click the Door tool  in the Toolbox to bring up
its settings dialog (select the Door/Window tool in the
Toolbox and hold down the mouse button to shift between
them). Choose D1 Sidelight Transom 8 from the library,
browse through the parameters and see what effect they will
have on the 2D and 3D representation. Click Cancel (to make
sure the settings are just as they were when you opened the
dialog box).



69

Step 10: Working with Doors, Windows and Skylights

Graphisoft ArchiCAD Step by Step Tutorial

Place the entrance door in the middle of the front wall of the
entrance enclosure:

- Select the Center Point geometry method.

- Hold the cursor over the external side of the front wall to
bring up a special snap point in the middle of it.

- Click on the snap point (point no. 1).
- Click above and to the right from the center point of the

door to define the opening direction (point no. 2).

2. Add Internal Doors

Select D1 from the door dialog box for the door opening into
the Exhibition space:

- Select the Corner Point geometry method.

- Click to place the door on the internal corner point of the
wall junction as shown (point no. 1).

- Click to the right of it to define the door position (point
no. 2).

- Click below and to the left of its center to define the
opening direction (point no 3).

Use the same door type for the restroom symmetrically on the
other side of the entrance enclosure. For the future toilet,
change the width to 2'-8" (750 mm) and its Door Panel to Style
1 (shown under the Frame, Panel, Shutter and Handle Types
in the dialog).

Place it by eye as shown in the picture above.
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3. Place Windows in a Curved Wall

Likewise place the windows into the curved wall of the
entrance enclosure.
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- Choose the Window tool  in the Toolbox.

- Select “W1 Casement” in the dialog box.
- Select the Center Point geometry method.

- Click to point no. 1 by eye to start placing the window.
- Click above the wall (point no. 2) to define the window

opening direction.
Similarly place a window to the other two rooms of the
entrance enclosure by eye.

For the glazed walls of the exhibition space, we will use
sliding doors.

4. Insert a Sliding Door

Choose D2 Sliding Door in the door dialog, set the reveal
value to 4" (70 mm) and select the corner point geometry
method option to place a door on both sides of the bottom
left corner of the exhibition space:

- Click to the inside corner point of the bottom left wall
junction (point no. 1 in the picture).

- Click with the cursor (double eye shape) above the corner
(point no. 2 in the picture) to define the wall into which
the door will be placed.

- Click with the cursor (eye shape) outside the wall (point
no. 2 in the picture) to define its opening direction.

- To place the second sliding door, repeat the steps above
only this time click to the right at step no. 2 with the
double eye cursor.

Next, replicate the sliding door in the southern wall:

- Select the door (click one of the corner points of the door
with the arrow tool or by the shift key; point no. 1).

- Select Edit/Multiply from the pull down menus.
- Type in 2 as the number of copies, select the Distribute

method and Click OK.
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- Click on one of the selection dots on its right side (point
no. 2).

- Move the cursor on the inside corner point of the bottom
right wall junction (the cursor is in the shape of a
checkmark (point no. 3).

- Click to finish the Multiply command.
Place the last sliding door to the corner of the eastern wall.

Deselect the door and switch to the 3D Window to check the
progress of the building.

5. Create Dimensions

The next step is to check the dimensions of the walls and the
openings.
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With the automatic dimensioning feature all the walls and the
openings of your building can be dimensioned with just a few
clicks. Simply select the items/points to be dimensioned and
ArchiCAD will do the rest:

- Go back to the Floor Plan.

- Select the Dimension tool in the Toolbox and make sure
the length dimensioning icon is selected in the Info Box.

- Select all the walls (select the Wall tool in the Toolbox
and choose Edit/Select All Walls).

- Select Tools/Automatic Dimensioning/Exterior
Dimensioning and enter the following values:

- Click OK.

- Click on the external side of the southern wall to define
the direction of the dimensions (point 1).
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- Click below the wall with the hammer icon to define the
distance of the first row of dimensions (point no.2).

Note that the rows of dimensions have been placed around
the four sides of the building. In ArchiCAD all dimensions are
associative, meaning if you change an element that was
dimensioned previously, after the modifications the
dimensions will follow the changes. View the resulting layout
in cross-section on Section A/1.

6. Edit Doors and Windows in Section and Elevation

Notice the door is a bit too wide; it’s better to align it with the
edge of the gallery slab.
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- Select the sliding door.
- Select Edit menu/Stretch.

- Click on the top left corner of the door to start stretching it.
- Move the cursor out in the horizontal direction and hold

down the shift key to constrain the horizontal movement.
- Click on either corner points of the edge of the slab

(cursor is a shape of a checkmark as shown above).

Go back to the Floor Plan: Note that the dimensions have
been automatically updated on the plan following the
modification in the section window.
Select the sliding door on the other side and stretch it
similarly; this time, do it on the plan to align it with the
dashed line of the gallery slab.
The next steps is to design the openings of the gallery.

Switch off the Show Ghost Story option (deselect Options/
Stories/Show Ghost Story) and the grid display (deselect
Options/Grid Display), because from now on this won’t be
used.
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Place the same door as the entrance door (D1 Sidelight
Transom) for the door to the balcony, the “W1 Casement” as
square windows in the northern wall, and the “W Round Piv”
round windows to both sidewalls of the gallery (enter 2’ (600)
as the parapet height for the round window). Do not worry
about their exact location, just place them by eye.

Open the north elevation and modify some of the windows:

- Stretch the square window of the entrance room on the
North Elevation.

- Replicate the window above the balcony.

7. Inserting Skylights into the Roof

On the Gallery level we will insert a skylight into the roof.
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To do this, select the Skylight Tool from the Tools palette as
shown.

Double click the Skylight Tool to open the settings dialog.
Choose the "Skylight Top Hung" object from the Object
Library.

At the bottom of the dialog set the layer to Roofs. Click OK.

Drag your cursor to the inside edge of the wall. Place the
skylight at the center of the wall using the Snap Point.
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The Skylight object will automatically cut a hole in the roof
and set its slope to the angle of the roof as shown in the
section cutaway below.
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Step 11: Adding Internal Circulation
Overview

This step will teach you how to create a custom stair using the Stair Tool. The Stair Tool lets you easily design and construct all
kinds of stairs required for ArchiCAD projects by selecting from a set of predefined geometry types, or by drawing the main
geometry of the stair and editing parameters.

Process to Learn

• Stair Tool

Creating a Stair Object
Selecting the Stair Type

Setting Flight and Tread
Defining the Stair Structure

Selecting the Handrail
• Create a Slab Opening

Starting the Step

Use your file from the previous step or open the file named Step-11.pln contained in the Step Files folder.
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Introduction
The Stair Tool automatically produces full-feature ArchiCAD
objects that you can save directly into your library of building
components. Using the Stair Tool, you can design stairs step
by step by defining the following components:

- Shape (geometry)

- Flights
- Landings

- Treads
- Structure

- Railing
- Attributes

What to Do

1. Add a Staircase to Reach the Gallery
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In this exercise we select a stair from ArchiCAD’s library to
provide internal circulation within the gallery:

- Return to the Ground Floor.
- Double-click on the Stair tool  in the Toolbox to

bring up the Stair Settings dialog box.

- From the parameter list on the right, switch off the
Automatic design.

- Set the dimensions of the desired stair in “General Flight
Parameters” and in “Tread Style and Parameters”.

- Choose the Right Railing and Rail Wired options, check the
rail geometry.

- Select “Stairs” from the Layers popup menu.

- Check how the staircase looks in 3D in the preview
window.

- Enter 270 degrees as the rotation angle and click OK to
confirm the settings.

After that, position the stair alongside the northern wall in the
exhibition space:

- Position the cursor over the bottom right corner point of
the door opening into the exhibition space (point no. 1).

- Type in “x 2’ +” (x 750 +) from the keyboard and see how
the cursor moves 2 feet (750 mm) to the right.

- Hit the “Enter” key.



77

Step 11: Adding Internal Circulation

Graphisoft ArchiCAD Step by Step Tutorial

2. View the Stair in 3D

The stair has been placed on the plan by its insertion point 2
feet (750 mm) to the right of the corner of the door. Check to
see how the room looks with the staircase. In ArchiCAD the
Camera tool is used to define perspective views. Place a
camera in the room to see how the room looks from that view:

- Select the Camera tool  in the Toolbox.

 - Click inside the room near the bottom right corner to
place the camera location.

- Click near the middle of the stair to locate its projection
target.

- Select the camera on the plan.

- Open the 3D Window.

3. Edit the Slab on the Gallery Story
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From the model it is clear that there is no opening in the slab
for the stairway; the outline of the slab needs to be modified
to circumvent the staircase:

- Go up one story to the Gallery level.

- Select the slab.
- Make sure the Slab tool is active in the Toolbox.

- Hold down the mouse button over the top edge of the slab
to bring up the pet palette and choose the first icon to add
a new node on it and pull it over the bottom right corner
point of the staircase (point no. 2).

- Using the same method create a new node (point no. 3) on
the slab edge between point no. 1 and 2, and pull it over the
top right corner point of the staircase (point no. 4).

- Similarly, create two more nodes and place them on the
left cornerpoints of the staircase.

- Deselect the slab (click outside it) and open the 3D
Window to check the result.
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Step 12: Defining Room Usage and Spaces
Overview

This step will demonstrate how to set up and assign different Zones to spaces of different use in a building. This allows the
project to be later evaluated on a Zone basis and to calculate the area of the building.

Process to Learn

• Defining a Zone
• Placing a Zone

• Placing a Zone Stamp
• Creating Room Information

Room Name
Room Number

Square Footage

Starting the Step

Use your file from the previous step or open the file named Step-12.pln contained in the Step Files folder.
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Introduction
With the Zone Tool, you can define spatial units called Zones
in your Project. Zones can be made up of rooms, groups of
rooms or even larger parts of a Project.

Zones appear on the Floor Plan as fills and zone stamps
linked to the zone fills. The zone fill designates the zone
space in the Project, while the zone stamp contains textual
information about the zone, including its name, number, area,
and other optional parameters such as the material of the
subfloor, materials of the walls and surface of the walls (with
or without their openings).

ArchiCAD zone stamps are Library Part elements. The
predefined zone stamps reside in the ArchiCAD Library, but in
many respects their behavior differs from that of other Library
Part types like Objects, Doors or Windows, as they are 2D-
only elements: they have a 2D symbol, a 2D GDL script and a
Properties script.

Zone stamps are intelligent parametric Library Parts
whose look, contents and behavior can be adapted to local
architectural practice.

What to Do
Next, define names of the rooms of the building using the
ArchiCAD’s Zone tool.

1. Place a Zone in Each Room of the Ground Floor
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The ground floor of the project will be assigned zone names
and numbers as shown :

Follow these steps to place the zones :

- Double click the Zone tool  in the Toolbox.
- Select “5 Education and Culture” from the zone categories

popup menu. Enter Exhibition Space as the zone name.

- (For the QEN metric files: Type “Timber Boarding” as the
Floor Type).

- Select the icon in the middle above the Zone Height value
to automatically place the zone object into rooms. Click
OK.
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- Click inside the room to place the zone. ArchiCAD
automatically fills the space to the face of walls bounding
the space.

2. Use the same procedure for the remaining rooms

For the zone category choose “9 Communication and Access”
for the Entrance and “7 Other Usage” for the Restroom and
the Toilet.
Now go up to the Gallery level by clicking the Gallery level in
the Navigator palette.

You will manually draw the outline of this zone, as one side
has no wall. For the Gallery use the same zone settings as for
the Exhibition space. To draw the zone manually:

- Select the first icon in the Info Box.

- Click one by one on the corner points of the slab to place
the zones (or use the Magic Wand on the perimeter of the
slab to trace it).
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Step 13: Adding Final Details
Overview

ArchiCAD libraries contain many types of prefabricated elements such as bathroom fixtures, cabinets, furniture, steel
components, graphic symbols and more.

Specialized libraries can be used for different applications and national standards. The objects in the libraries are also
parametric items, just like the door/window objects.

Process to Learn

• The ArchiCAD Library

• Object Tool
Viewing Objects

Editing Objects

Placing Objects

Starting the Step

Use your file from the previous step or open the file named Step-13.pln contained in the Step Files folder.
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Introduction
Whenever you need either a complex element that exceeds
the capabilities of the basic tools or a type of element with a
specific role and behavior, you can rely on predefined, fully
parametric individual objects (Library Parts) or objects
stored in a folder or set of folders called the Library. These
objects are accessed using the Object Tool in the Toolbox.

Library Parts comprise a 2D Symbol and a 3D description
in GDL (Geometric Description Language), as well as some
optional information such as an additional 2D description, a
user interface script or a component definition.

      

What to Do
We now need some furniture and fittings in the rooms, such
as handrails in the Gallery and fixtures in the Restroom. For
this project we have provided only an extract of the standard
ArchiCAD library. To see all the standard objects of ArchiCAD,
browse the ArchiCAD Library folder on your computer.

1. Place a Handrail on the Left Side of the Balcony
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- Double-click on the Object tool  in the Toolbox to
bring up its settings dialog.

- Select the “Railing Horizontal” object from the library.

- Click OK.

- Select the diagonal geometry method in the Info Box.

- Click inside the bottom left corner of the balcony slab
(point 1) to start placing the object.

- Click by eye to define its length inside the top left corner
of the balcony slab (point 2).
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Now place the railing object in all the necessary places inside
the building. When the orientation of the railing changes to
horizontal, open the settings dialog and modify the rotation
angle.
Check it in the 3D Window and note that there are only three
vertical columns in the long railing on the edge of the gallery
slab; this is clearly not strong enough. Go back to the Floor
Plan, select the railing and open its settings dialog. Modify the
number of posts to 10 in Posts Parameters and confirm the
settings.

2. Add Bathroom Fixtures
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Before adding the restroom fixtures as shown in the picture,
go down to the ground floor plan and select the ‘Orthogonal’
Geometry method for the Object tool.

Zoom in to the Restroom and open the Object Settings dialog
box. Select the ‘WC’ object, change its rotation angle to 180
degrees and place it in the Toilet. In the same way you can
place the ‘Basin 02’ object next to the entrance door of the
Restroom.

3. Add a Piano Object

To furnish the Exhibition Space place a Piano in the room. In
the Object Settings dialog select the Piano object, modify its
rotation angle to 90 degrees, and put it in the center of the
room. To finish it off, place a Stool object in front of the Piano
and check the result in 3D.
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Step 14: Creating a Ceiling Plan
Overview

In this Lesson, we explore placing, editing and creating a 2D ceiling pattern and placing ceiling light objects using the Fill Tool
and Lamp Tool.

Ceiling lights are 3D objects, so when placed on a ceiling, they become both a 2D graphical element as well as an element
containing light.

Process to Learn

• Lamp Tool
• Fill Tool

• Creating Ceiling Patterns
• 2D and 3D Ceilings

• Changing View Sets
• Control Box

Special Snap Point

Starting the Step

Use your file from the previous step or open the file named Step-14.pln contained in the Step Files folder.
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Introduction
Ceilings are created in 3D using the Slab or Roof Tool and
Lamps are applied to those surfaces. The 3D ceiling,
however, does not create a 2D representation for the Ceiling
Plan. Therefore, we must also place a Fill pattern to indicate
the ceiling for the reflected ceiling plan. This exercise
describes how to create and place the ceiling fill pattern and
the associated light objects.

- Fills are geometric patterns that have three view options:
solid, bitmapped and vectorial. In a project, all fills are
displayed either as bitmapped or vectorial. You can
change this option under Display Options command in
the Options Menu.

- The Lamp Tool is used to place additional light sources as
library parts into the project. Most of the Lamp Tool’s
settings, features and techniques are identical to those of
the Object Tool. The additional Lamp controls affecting
their behavior in PhotoRenderings are found in the
Parameters or Custom Settings.

What to Do

1. Set the View Set to "Ceiling Plan" using the Navigator

To set the View Set to the Ceiling Plan, click the View Sets tab
in the Navigator palette and double-click the "Ground Floor"
in the Ceiling Plan view set.

2. Create a Ceiling for the Exhibition Space
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A gypsum board ceiling is used in the Exhibition Space. To
create a gypsum board pattern, select Fill Types from the
Options menu. Click the popup menu and select the Render
fill pattern.

- Click the New button, select Duplicate and enter "Gypsum
Board Ceiling" for the fill name.

- Click OK, and then click OK in the Fill Types dialog box.

- Go to the Fill Tool and double click the tool to open the
Fill Settings dialog.

- Select the new fill "Gypsum Board Ceiling" and click OK.

     

- Click the Magic Wand and click the cursor under the
balcony within the Exhibition Space.
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3. Create a Ceiling for the Entrance

The Entrance will use the ceiling pattern we created in Step 3.
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- Open the Fill Settings dialog by double clicking the Fill
Tool.

- Select "Ceiling Tile" from the popup menu and click OK.

- With the Fill Tool selected, click your cursor on the top
right corner of the Entrance area and click the other 3
corners. To close the Fill, click your cursor on the start
point (point no. 1).

Now modify the northern edge of the fill pattern to align it
with the curved wall:

- Select the fill.

- Make sure the Fill tool is active in the Toolbox.
- Hold down the mouse button over the edge of the fill

(between points 4 and 1) and select the second icon as
shown from the pet palette (as shown).

- Pull the edge of the fill over the curve of the wall to align

To center the fill pattern within the room and open the Fill
Settings dialog. Change the origin point to "Link to Fill
Origin." Click OK.

4. Select a Light

To add a light to the ceiling plan we must select a lamp object
from the Lamp Tool.
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- Open the Lamp Tool.
- Select the Recessed Spot lamp from the ArchiCAD library.

- Select the center insertion point on the light.
- Click OK.

      

To insert this lamp in the center of the space, we must use the
Special Snap Point in the Control Box.

- Set the Snap Point to Half.

- Select the Special Snap Point in the Control Box.
- Click the first corner of the room (point 1) and the

opposite corner of the room (point 2).
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Repeat this for the opposite side of the Exhibition Space.
Once completed, place a Recessed Spot in the center of the
two lights by repeating the same steps.

Finally, we need to place wall lamps on the east and west
walls of the Exhibition Space.

- Open the Lamp Tool.

- Select the Wall Lamp object.

- Enter 90 degrees as its rotation value and click OK.
- Use the same steps as previously used to place the lamp

on the center point of the wall (point no. 1) between the
edge of the balcony above and the north wall.

      

- Place the east Wall Lamp (point 2) using the same steps
above except enter 270 as its rotation value.
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Step 15: Placing the Building on a Site
Overview

This step will demonstrate several techniques for creating a site. Both the Slab Tool and the Mesh Tool can be used to create a
site plan. The Slab Tool creates flat horizontal surfaces which can be stacked while the Mesh Tool creates a topographic surface.

We will also learn how to use the Spline Tool to create contour lines and transform them into a mesh.

Process to Learn

• Spline Tool

• Converting Splines to Mesh
• Mesh Tool

• Level Dimension Tool
• Gravity Tool

Starting the Step

Use your file from the previous step or open the file named Step-15.pln contained in the Step Files folder.
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Introduction
• Spline Tool: The Spline Tool is capable of generating an

infinitely variable series of custom curves. These curves
are commonly defined as Natural Splines, Bézier Curves or
Freehand Splines. The Tool gives greater freedom in
defining free-form structures and objects without the
constraint of the circular Arc Tool.

                

• Mesh Tool: The Mesh Tool allows for the creation of an
editable and continuous 3D surface made up of triangular
polygons. This mesh is appropriate for a variety of uses,
but the most obvious one is for terrain and site creation.

• Gravity Tool: This tool allows the user to access vertical
(Z) data from existing slab, roof and mesh objects in both
the Floor Plan and 3D Windows. When a wall is drawn
or an object is placed using the Gravity Tool, it will
automatically snap to the Z coordinate.

What to Do

1. Set the View Set to "Site Plan" using the Navigator

To set the View Set to the Site Plan, click the View Sets tab in
the Navigator palette and double-click the "Ground Floor"
in the Site Plan view set.

2. Define the Site Property Line and Building Cut

Using the Mesh Tool's line type option we can assign the
property line type we created in Step 3.
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- Open the Mesh Settings dialog from the Toolbox.

- Select the "Property Line" type from the Floor Plan
attributes.

- Select the "Terrain" layer.

Zoom out to see more of the project. With the Mesh Tool
selected, select the Rectangular geometry method from the
Info Box and draw a rectangular mesh as shown in the
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following picture. Now cut a hole on it around the paving slab
of the building:

- Select the Mesh so that its corners are highlighted.
- Make sure the Mesh tool is active in the Toolbox.

- Click on a corner point of the site mesh to start cutting a
rectangular hole.

- Click on the diagonally opposite corner point of the
paving slab to finish the rectangular hole. When the dialog
box appears, select "Create a Hole" in the dialog and
click OK.

3. Create Contours with the Spline Tool

Before we can create a 3D mesh, we must define the contours
of the site.
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To do this we will use the Spline Tool and the natural spline
drawing process.

- Open the Spline Settings dialog from the Toolbox.
- Select the "Terrain" layer and click OK.

- Select the Spline Geometry method from the Info Box.
- With the Spline Tool selected, draw several contour lines

as shown below. Start and end each spline so that the
spline overlaps the edge of the property line.

        

4. Convert the Splines into a 3D Mesh

The next step is to convert the splines to a mesh.
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This is done using the Magic Wand, an auto-trace tool.
- Select the Mesh so that its corners are highlighted.

- Select the Mesh Tool so that it is active.
- Select and activate the Magic Wand.

- Drag your cursor over the edge of the first spline until the
Magic Wand changes shape and click.

- In the dialog that appears, select "Fit to User Ridges" and
click OK.

         

- Repeat this step for each of the contours until all contours/
splines have been converted into mesh points.
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5. Define a Height for each Contour

Mesh points can be assigned a Z value to establish their
height. This value can be applied to all points along a spline.

- With the mesh selected, drag your cursor to a mesh point
along the first contour and click the node.

- In the Pet Palette, click the middle button.
- In the dialog that appears, select "Apply to All" and enter 1'

(300mm) as the height. Click OK.
- Repeat this step with each contour.

6. Create a 3D View

Check your mesh work. If you want to see all the Model and
not just the terrain, deselect the Mesh that is currently
selected. Go to the Image Menu and select 3D Projection
Settings. Make sure you are in the Parallel Projection
Settings dialog box. Select Isometric and click OK.

7. Place the Level Dimension using the Gravity Tool

Using the Level Dimension Tool we can place dimensions that
are automatically linked to the terrain. To do this we must
activate the Gravity Tool.

- Deselect the mesh in the Floor Plan Window.

- Open the Level Dimension Tool from the Toolbox and
select the Notes-Site Plan layer. Click OK.

- With the Level Dimension Tool selected, activate the
Gravity snap for the Mesh from the Control Box.

         

- Drag the cursor to a contour mesh point and click to place
a level dimension.

- Repeat these steps for the remaining contours.
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Part Four: Measuring and Costing a Building

Step 16: Calculating Building Information
Overview

This step will demonstrate how to list the project information you assigned to elements and objects. We will review several types
of list options provided with ArchiCAD and discuss how you can customize these templates for your specific project use.

Process to Learn

• Descriptions of List Schemes

• List Elements
• List Components

• List Zones
• Calculate Menu Appearance

Starting the Step

Use your file from the previous step or open the file named Step-16.pln contained in the Step Files folder.



96

Step 16: Calculating Building Information

Graphisoft ArchiCAD Step by Step Tutorial

Introduction
ArchiCAD’s integrated Virtual Building construction database
can reveal the number of elements in a project, the elements’
spatial disposition or the quantity of the elements’
components through the complex feature set of the Calculate
Menu.
Having analyzed project data and relevant database
information, ArchiCAD can generate three fundamental types
of calculation reports: Elements List, Components List and
Zone List.

What to Do

1. Set the View Set to "Floor Plan" using the Navigator

To set the View Set to the Floor Plan, click the View Sets tab
in the Navigator palette and double click the "Ground Floor"
in the Floor Plan view set:

2. Create an Elements List

The Elements Lists are best used for creating schedules and
inventories, and to display the parameters of construction
elements in a project. Parameters, components and
descriptors can also be included in the lists.
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To create an Elements List, select the Basic option from List
Elements in the Calculate menu.

3. Create a Component List

The Component Lists are generated when bills of materials,
quantity takeoffs or price lists are required. Typically in these
reports, Component type properties are summed and displayed.
However, certain element parameters can also be listed.
To create a Components List, select the Basic option from
List Components in the Calculate menu.
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4. Create a Zone List

Zone Lists are generally used to create room schedules and
finish schedules. Zone Lists can include parameters of zones
and related construction elements.

To create a Zone List, select the Basic option from List Zones
in the Calculate menu.
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Step 17: Creating Building Schedules
Overview

Using the Interactive Schedule editor, you can create a schedule a variety of project information such as door and window
schedules, furniture schedules, equipment schedules and more.

The schedules are linked to the parameters within each object in order to link information such as size, UV rating, number of
items, hardware type, and material.

Process to Learn

• Interactive Schedule

• Door and Window Parameters
• Editing the Parameters

• Creating a Window Schedule

• Viewing the Schedule

Starting the Step

Use your file from the previous step or open the file named Step-17.pln contained in the Step Files folder.
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What to Do

1. Format the Window Schedule
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To format the Window Schedule, go to the Calculate Menu
and select Settings... from the Interactive Schedule option.

- Select Basic_Window_Schedule from the Schedule
Settings popup option. We will use this as a template for
our custom Window Schedule.

- Click the Duplicate button.

- Enter a new name for the Window Schedule called
Project_Window_Schedule and click OK.

     

- Click the Fields tab

- Open the Window/Door tree from the Available
Parameters and select the Height option so that its check
mark appears in the selection box.

- Scroll down further and select the select the Width option.

- In the Parameters to List column, select the left edge of the
Height parameter and drag it up to set the sequence in
which the columns will appear within the schedule.

- Repeat this for the Width parameter and click OK when
finished.

2. Preview the Window Schedule

The Preview option can be used to view how the schedule will
appear. The Preview option can also be used as an editable
spreadsheet that can update information within the model.
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- Go to the Calculate Menu and select Preview... from the
Interactive Schedule option.

- Select Project_Window_Schedule from the Schedule
Settings popup option. The schedule will reflect the
changes to the Settings dialog.

- Next, edit the title for the window height. Double-click the
Height column header.

- In the Header Properties dialog, click the Display Units
checkbox to OFF. Click OK.

- Repeat this for the Width header.
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- Now adjust the column widths. To do this, click and drag
your cursor at the top edge of a column.

- Drag the column edge to the position width desired.

3. Edit the Window Schedule

The interactive schedule is an editable spreadsheet that can
update information within the model.

- Select the first row within the schedule so that it is
highlighted.

- Click your cursor within the ID section

- Change the ID to W-1.
- Click your cursor within the Material section.

- Change the material to Wood.

- When you are finished updating the schedule, click the
Apply Changes button to change the objects in the model
to reflect the updated schedule.

- Click the Close button when finished.

4. Create a Window Schedule

To view the Window Schedule you can either place it on the
drawing or open a list window. For this exercise we will place

it on the floor plan. First create a story that is dedicated to
schedules.

- To do this, go to the Options Menu and select Stories/
Story Settings.

- In the dialog box highlight Gallery and click Insert
Above.

- Now name the new story Schedules. Click OK.

- Go to the Calculate Menu and select Preview... from the
Interactive Schedule option.

- Click the Place button within the Schedule on Drawing
section of the dialog.

ArchiCAD will place the schedule onto your floor plan.
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Part Five: Presenting the Design to a Client

Step 18: Using Perspectives
Overview

In this Lesson, you will learn how to create and store single point perspectives, how to use the camera settings, how to edit the
PhotoRendering Effects settings and how to create a final PhotoRendering using different rendering backgrounds, effects and
sizes.

Process to Learn

• Camera Tool
Placing a Camera

Placing Multiple Cameras
• Camera Settings

• PhotoRendering Settings
Effects

Size & Background

Starting the Step

Use your file from the previous step or open the file named Step-18.pln contained in the Step Files folder.
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Introduction
Double-clicking on the Camera Tool's icon in the ArchiCAD
Toolbox will open the Camera Settings dialog box. The
contents of the Camera Settings dialog box is different for all
three types of Cameras.
This dialog box and the Floor Plan are simultaneously active,
so you can alter the settings, the camera locations and
orientations without repeatedly opening and closing the
window. However, the dialog box disappears while the 3D
Window is open.

You can choose the camera type either by clicking the
corresponding tab at the top part of the dialog box or as a
Construction Method from the Info Box.

What to Do

1. Set the View Set to "Site Plan" using the Navigator

To set the View Set to the Site Plan, click the View Sets tab in
the Navigator palette and double click the "Ground Floor" in
the Site Plan view set.

2. Set up the Camera
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When you take a photograph with a real camera, you must
adjust the camera height, view, view angle, etc. Similarly, we
must set the camera settings before placing using the Camera
Tool.

- Open the Camera tool from the Toolbox.

- Click the Camera tab at the top of the dialog box.
- Click the Rename button.

- Type the name "Perspectives".

Now we can create the new perspective camera settings.
- Adjust its view cone angle to 40 degrees and its target Z

height value to 12’ (3600mm).
- Click Apply to confirm the settings.
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3. Place the Camera

Once the camera settings are set, we can place the camera in
the Floor Plan Window.

- Place the camera near the top left corner of the site to view
towards the building.

- Select it with the Arrow Tool and open the 3D Window.

Now click the Project Map tab and notice that there are now
two perspective cameras listed.

4. Create a View Set for Images

As we create views of the project we can save these views as
pre-sets within the Navigator. These views can then be
accessed in both ArchiCAD and PlotMaker.
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- Click the View Sets tab within the Navigator palette.

- Select "Create a New Folder" from the popup menu.
- With the folder selected, type the new name "Images".

- With the 3D Window active, select "Save Current View..."
from the popup menu within the Navigator palette.

- Enter the name "Northwest View" in the text box and the
click OK button.
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5. Set up the PhotoRendering and Effects Settings

The PhotoRendering settings are controlled from the Image/
PhotoRendering Settings/Effects menu point. Be sure to use
the ArchiCAD Rendering Engine and that the options are set
as displayed.

Change to the Size and Background tab page and check
Picture at the top to import a background picture. Select from
your Step Library/Background images/
Sky_cloudy1_photo.jpg (select “JPEG Image type” from the
“Files of type” popup menu in the dialog to be able to choose
the background picture).

Check Show Picture at the bottom of the preview to adjust the
frame of the rendering against the background image.
Position it as desired and click OK.

6. Create a PhotoRendering

Execute the Image/PhotoRender Projection command and
wait for the result.

When the picture is complete, it can be saved in different
formats using the File/Save as command.
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Step 19: Developing an Animation
Overview

Animations are a great way to present a design and take a guided tour through a project. In this Lesson, you will learn how to
define a Fly-Through Path for an animation using the Camera Tool and how to create and store multiple animations.

Process to Learn

• Camera Tool
Placing a Camera

Placing Multiple Cameras
• Camera Settings

• Path Settings
• Creating an Animation

• Compression

Starting the Step

Use your file from the previous step or open the file named Step-19.pln contained in the Step Files folder.
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Introduction
Placing several cameras defines a Fly-Through path whose
parameters you can adjust in the Path dialog box. Open the
Path Dialog Box by clicking the Path button at the bottom
left of the Camera Settings dialog box.

Only one camera will be active at a time. This is the only
camera displayed with its sun and view angle markers. The
active camera is always the one that was last placed, unless
you select another one. Any cameras placed on the Floor Plan
will be attached to the current Fly-Through path after the
active camera.

What to Do

1. Set up the Camera

Select the Camera Tool from the Toolbox and make sure
that the Camera tab page is chosen in the Camera/VR
Settings dialog box.
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The camera tool allows us to create different camera presets
that are saved with the Camera Tool. Let's create a new pre-
set for the animation path.

- Click the New button.
- Type in the name "Animations" and click OK.

       

2. Place the Cameras along the Animation Path

Place three cameras along a path as shown below.
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After placing the cameras, a Fly-Through path will be defined
automatically. If you want to change the settings of the
cameras separately, double-click on the Camera Tool and
browse among the cameras.

3. Set Animation Path Settings

Click the Path... button. Set the Motion Controls, the Display
Option and the number of the Inbetween frames as indicated.

Each camera you add to the path is considered a keyframe.
ArchiCAD can interpolate between keyframes to create
Inbetween views, which produce a smoother animation. But
increasing the number of images requires more time to create
and more disc capacity to store.

4. Create the Animation

Go to the Image Menu and select Create Fly-Through.
Choose options as desired:

• Source: This option allows you to toggle between the 3D
Window or Photorendering Window option and to
define which frames are rendered.

• Result: With this option, choose the number of colors for
the animation and the compression. Graphisoft
recommends using Cinepak compression. The better the
image quality, the longer it will take to process.

Save, and when ArchiCAD is finished processing, open the
Animation file. To open the Animation, go to the location you
chose to save the Animation and double-click on the file.
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The animation will create a series of images similar to the
images shown below:
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Step 20: Viewing Virtual Reality
Overview

This step allows you to create a navigable object or scene taking advantage of virtual reality technology. For a VR Object, you
define a spherical path for the camera and navigate along the sphere.

For a VR Scene, you create a navigable panoramic scene. You define one or a series of cylindrical panoramas to be viewed in
the virtual reality player application. This allows you to stand at a single point and turn 360 degrees to view the building space
of your model.

Note: If you only have a demo version of ArchiCAD, you will not be able to do this exercise as described here, because
saving files is not available in the demo version.

Process to Learn

• VR Object Tool
• VR Scene Tool

• Placing a VR Object or Scene
• Creating a VR Movie

• VR Settings
• Compression

Starting the Step

Use your file from the previous step or open the file named Step-20.pln contained in the Step Files folder.
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Introduction
• Virtual Reality Object: ArchiCAD allows you to create

navigable objects taking advantage of virtual reality
technology. You define a spherical path for the camera
along which the viewpoint can optionally be positioned
and navigated. The navigable object can be viewed in the
QuickTime® VR MoviePlayer application.

• VR Scene: ArchiCAD allows you to create navigable
panoramic scenes using virtual reality technology. You
define one or a series of cylindrical panoramas to be
viewed in the virtual reality player application.

What to Do

1. Define the VR Object
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Open the Camera Tool from the Toolbox, select the VR
Object tab page and enter the object information as indicated.
Enter the Radius as 50' (15000mm) and Center Z as 5'
(2000mm). The remaining parameters can remain at their
default settings.

• Place the VR Object: A click on the Floor Plan
determines the center of the VR Object, which will show
both the initial direction of view and the extent of view.
Additional clicks on the floor plan will not create new
cameras; you can only have one camera active at a time.

• Configure the Rendering Settings: Open the
Photorendering Settings or 3D Window Settings from
the Image Menu to set the effects and settings, depending
on which source you choose.

• Create the VR Object: Choose Create VR Object from
the Image Menu. Choose options as desired:

- Source: 3D Window or Photorendering Window
- Result: Choose Millions of Colors for the VR Object and the

Image compression. (Image Compression is supported
only by QTVR 2.0 Engine.) Graphisoft recommends using
Cinepak compression.
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Note: You must have the appropriate QuickTime VR
Extensions properly installed on your computer in order to
take advantage of this option.

        

The better the image quality, the longer it will take to process.
Save, and when ArchiCAD is finished processing, open the
VR Object file. To open the VR Object, go to the location you
chose to save the VR Object file and double-click on the file.

2. Set the View Set to "Floor Plan" using the Navigator

To set the View Set to the Floor Plan, click the View Sets tab
in the Navigator palette and double click the "Ground Floor"
in the Floor Plan view set:

3. Setup the VR Scene
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Open the Camera Tool from the Toolbox, select the VR
Scene tab page and enter the object information as indicated.

• Place the VR Scene Nodes: A click on the Floor Plan
places the center of the VR Camera.

- Panorama 1: The first click places the camera and the
second click defines view direction.
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- Additional Panoramas: To place additional panorama
cameras that are linked, click the center point of the first
camera and click again to place camera or (with Camera
Tool still selected) draw a line between center nodes of
unconnected cameras.

• Create the VR Scene: Choose Create VR Scene from the
Image Menu. First choose which type of VR Scene to
render. ArchiCAD offers three types:

- VR Scene - Saves all panoramas defined on the plan and
includes a control file to navigate between panoramas.

- Panoramas - Saves only individual panoramas and does
not include the control file.

- Pictures - Saves pictures of the panoramas for editing as
PICTs.

• Select the VR Scene. Next enter the final rendered image
size of the VR Scene. The parameters are measured in
pixels. The Image Height and Image Length refer to the
rendering size while the settings for the Window Size in VR
Player refer to the size of the VR viewing window. The View
Cone is the angle of view of the camera and the Initial View
is the angle of the camera when the VR first starts.
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Finally, choose Millions of Colors for the VR Object and the
Image Compression (image compression is supported only by
QTVR 2.0 Engine). Graphisoft recommends using Cinepak
compression. The better the image quality, the longer it will
take to process.

Save, and when ArchiCAD is finished processing, open the
VR Scene file. To open the VR Scene, go to the location you
chose to save the VR Scene and double-click on the file.
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Step 21: Creating a Sun Study
Overview

This step uses the Create Sun Study... command to generate a series of normal or photorendered 3D pictures defined by the
current 3D Projection Settings, the current 3D Window or PhotoRendering Settings respectively, and the Sun position
settings defined in the Create Sun Study dialog box, similarly to the Create Fly-Through command.

Process to Learn

• Sun Settings

• Setting Camera View
• Create Sun Study

• Compression Options
• Source Options

• Camera Settings

Starting the Step

Use your file from the previous step or open the file named Step-21.pln contained in the Step Files folder.
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Introduction
ArchiCAD allows you to generate a series of normal or
photorendered 3D pictures defined by the current 3D
Projection Settings, the current 3D Window or
Photorendering Settings, and the Sun position settings
defined in the Create Sun Study dialog box.
These generated images mimic the effect of the sun and the
resulting shadows on the modeled building over a period of
time.

What to Do

1. Set the View Set to "Site Plan" using the Navigator
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To set the View Set to the Site Plan, click the View Sets tab in
the Navigator palette and double click the "Ground Floor" in
the Site Plan view set.

2. Set up and Select the Camera

Open the Camera Tool from the Toolbox, click the camera
tab and select the "Perspective" view from the popup menu
that you created in Step 19. Select the camera showing the
Northwest view by clicking the up/down arrows next to
"Camera" as shown.

Now that the view is set, we must define the sun settings for
the time of year, time of day and location.

- Click the Sun button.
- Set your location in the world by clicking the Set City.

- Set the time as 9:30.

3. Create a View in the 3D Window

With the camera selected, open the 3D window to view the
perspective.
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4. Create a Sun Study

Go to the Image Menu and select Create Sun Study.

- Select PhotoRendering Window as the source.
- Set the date to April 21.

- Set the start and end time for the study as follows:
From: 9:30

To: 18:30 (6:30 pm)
- Set the result as a QuickTime movie from the popup

menu. Use the Cinepak compression which Graphisoft
recommends for animations.

• Save, and when ArchiCAD is finished processing, open
the Sun Study file. To open the Sun Study file, go to the

location you chose to save the Sun Study and double-click
on the file. The file will open as a QuickTime movie. Click
the Play button on the movie.
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Step 22: Defining a 3D Cutaway
Overview

This step introduces you to the option of cutting away your model in 3D. This allows you to create 3D cutaway sections, plan
views and details of your model.

Process to Learn

• Marquee Tool
• 3D Cutting Planes

• 3D Cutaway Options
• 3D Cutaway Section

• 3D Cutaway Plan

Starting the Step

Use your file from the previous step or open the file named Step-22.pln contained in the Step Files folder.
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Introduction
Marquee Tool: You can use the Marquee Tool to view only
specific parts of the 3D model by drawing a marquee area
around the details you wish to either include or exclude from
the 3D image. This technique can be applied to either the
current story or to all stories, depending on the construction
method chosen.

3D Cutting Planes: Choosing the 3D Cutting Planes…
command displays the 3D Section dialog box. By using 3D
sections, you can get either ordinary cross sections or special
sections to visualize the project in new ways.
3D Cutaway: 3D Cutaway is an imaging mode in ArchiCAD.
If it is active, the cutting places defined in the 3D Cutting
Planes dialog box are applied to the model every time it is
rebuilt.

Note: that 3D cutting planes can only be defined and the
cutaway performed with the 3D Window active.

What to Do

1. Marquee Tool

Your Marquee Tool can be used to highlight a specific area of
the building. The model will be clipped at the Marquee’s
boundaries. The thin marquee images one floor and the thick
marquee images all floors.
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- Select the Marquee Tool and select the thick Marquee
option from the Info Box.

- Go to the Floor Plan and define the area of the building to
be clipped. Note that the area to be clipped is outside the
marquee.

- Now go to the 3D Window to see a clipped area of the
building as shown below.

- To cancel the Marquee, activate the Context menu by
clicking with the right mouse button (Windows) or with
the Ctrl key pressed (Macintosh), and choose the Remove
Marquee command. You can also double click anywhere
outside the Marquee.

2. 3D Cutting Planes

The three basic orthogonal representations of your building
(front, side and top) are displayed in the 3D Section dialog
box.
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Note: This command is not available if the 3D Window is
closed or empty.

- Open the 3D Projection Settings dialog box from the
Image Menu and click the Parallel Projections button.

- Now select the Isometric Axonometry option from the
preset popup menu in the Parallel Projections dialog.

- Open the 3D Cutting Planes from the Image Menu.
- Draw a line through the Ground Floor in one of the two

side views. This line represents a cutting plane
perpendicular to the given orthogonal view.

- An Eyeball Cursor will appear. Select the lower part of the
drawn line indicating the area to be removed.

The Fill Material & Edge Pen of Cuts controls allow you to
highlight the edges and surfaces of elements cut in 3D

Sections. You can create special section cut surfaces with
different colored edges, as well as cut surfaces having custom
material definitions.

- To create such highlighting, click the Custom radio button
and choose a material from the popup menu and/or a pen
from the palette.

3. Activate the 3D Cutaway

To activate the 3D Cutaway, select its Menu item. A
Checkmark placed before the name of the command
indicates that it is active. To deactivate 3D Cutaway, choose
the command again and the Checkmark disappears.

Inactive Active

4. View the 3D Cutaway from Different Views

Activate the 3D Window to see the cutaway of the building.
To render a final image with shadows, select PhotoRender
Projection from the Image menu.
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5. Clear All Cutting Planes

To remove all cutting planes, click the Clear All Cutting
Planes button, then Rebuild, and finally choose the 3D
Cutting Planes command.

Hint: The number of cutting possibilities offered here is
much greater than you generally need in architecture. You
can, however, make good use of them when you are

dealing with non-orthogonal details or when showing
material cutaways.

6. Save Your File

In the next step we will use the ArchiCAD Model you have
been creating to develop Layout Sheets for publishing,
printing and plotting. To Save the File, go to the File menu
and select Save. If you have not yet saved your work, then a
dialog box will appear. In the dialog select where on your
computer you would like to save the file.
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Part Six: Producing and Publishing Drawings

Step 23: Creating the Sheet Layouts
Overview

PlotMaker is a stand-alone program for creating, publishing, plotting and printing Layouts into a final architectural
documentation.

In this exercise we will review the process of creating sheet layouts in PlotMaker using the Navigator, a Master Layout, Drawing
Subsets and the Layout Settings. When we are finished setting up the layouts, we will place the drawings and set the drawing
views in Step 24.

Process to Learn

• Using the Navigator Palette
• Creating a Master Layout

• Creating Layout Sheets
• Creating a Titleblock

• Placing Text

Starting the Step

Open the file named Step-23.lbk contained in the Step Files folder.
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Introduction
Architectural documentation consists of a collection of different drawings – floor plans, details, cross-sections, views, 3D views,
etc. In PlotMaker you collect and arrange all of these plans in a Layout Book. The Layout Book includes all the electronic
information necessary for a project’s entire documentation in a single file (extension .lbk) – similar to the collection of pages
and chapters that make up a real book.
A Layout Book consists of the following elements: Layouts, Drawings, Subsets, and Master Layouts. You can navigate
among and organize, add or remove these elements using the Navigator palette. The Navigator palette also serves as a visual
outline of the structure and contents of your Layout Book. The following image is a view of the Navigator, Layouts, Drawing
Subsets and placed Drawings that we will develop in the following steps.

Functions of the Navigator

- Create and organize the elements
of your Layout Book

- Navigate within the Layout Book

- Open a new Layout Window or
Drawing Window

- Set and adjust parameters for a
Book, Layouts, Subsets and
Drawings

- Update Drawings
- Give a name to Layouts or Subsets
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What to Do

1. Set up the Master Layout

The Master Layout ensures a uniform appearance for your
project documentation.
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Once you create an element (frame, logo, etc.) within the
Master Layout, that element will appear on every Layout to
which you have applied that Master Layout. You can also
define multiple Master Layouts for a single Layout Book.
Let's start by setting up the Master layout.

- Open the Master Layout Settings... from the Book menu.
- Highlight the default name "Master 001" and rename it

"Titleblock Master".
- Set the sheet size to Architectural-B or 1' x 1'-6" (Metric is

A3-Oversize or 450mm x 330mm).

     

2. Create a Titleblock Master

Now that the master layout settings are saved, let's activate the
Titleblock Master so we can create a template.

- Double-click the Titleblock Master in the Navigator so
that it displays in bold.

- Select the Line Tool from the Toolbox and select the
rectangular control option in the Control Box.

- Click in the lower right corner and draw a rectangle to
create an outline for the titleblock.

- Open the Text Settings from the Toolbox and enter 20
points for the text size.

- Select the Text Tool and click inside the titleblock. When
you see a flashing cursor, type in the name "Step Project".

- When finished, click your cursor outside the text box to
confirm the text entry.
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3. Set up the Layouts

The next step is to create a list of sheets for the project.
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The Navigator is used to create and manage these layouts.

- Double-click Layout 001 in the Navigator so that it
displays as bold.

- Click the arrow popup button next to Tree by Subsets and
select Layout Settings.

- In the Layout Settings dialog, type the name A1-Site Plan.
- Click OK.

- Click the arrow popup button next to Tree by Subsets
again and select New Layout.

- Repeat these steps to create three additional sheets:

A2-Floor Plans
A3-Ceiling Plans

A4-Elevations & Sections
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Step 24: Placing, Positioning and Viewing Drawings
Overview

In this exercise we will add drawings to the layout sheets we created in the previous step. When drawings are added to a
PlotMaker layout, the drawings are composed on the layout sheet and are linked to the ArchiCAD model. Any updates and
changes to the model will automatically be reflected in the PlotMaker drawing.

Process to Learn

• Linking to ArchiCAD Project

• Composing a Drawing
• Drawing Frame

• Adding Drawing Information
Drawing Title

Drawing Scale

Starting the Step

Use your file from the previous step or open the file named Step-24.lbk contained in the Step Files folder.
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Introduction
A Drawing is imported and placed on Layouts with its
corresponding screen image or as an empty frame. Then, if
needed, the Drawing can be edited in the Drawing Window.
A hotlink exists between the imported file and the
placed Drawing. Every time you open or rebuild the Layout,
the hotlinks are updated.

PlotMaker supports multiple file formats, so drawings can be
added to a Layout Book from any of the following file types:

• PlotMaker Formats
- Supports PlotMaker Drawings, Layouts and Layout Book

file types.

• ArchiCAD Formats
- Supports ArchiCAD Solo Project, Archive and Backup file

types. View sets belonging to an existing ArchiCAD file are
recreated in PlotMaker's Navigator palette.

• Drawing Type Formats
- Supports image formats such as JPG, GIF, BMP, PICT and

PSD.
• Linked Drawing Object Formats
- Supports OLE (Object Linking and Embedding) Objects

coming from any OLE enabled application. OLE
applications include Microsoft Excel, Microsoft Word,
CorelDraw and Photoshop.

• HPGL Format
- Supports PLT, the industry standard plot file type.

What to Do

1. Set the Layout to A1-Site Plan
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Before we add drawings to a layout, we must activate that
layout. To do this, double-click the A1-Site Plan layout in the
Navigator so that it displays as bold.

2. Add Drawings to the Layouts
To place a Drawing onto a Layout, use the Import command.
This will allow you to add drawings from the ArchiCAD
model you created.

- Select Import from the File menu.
- Select "ArchiCAD Solo Project" from the Files of Type

popup menu in the Add dialog.
- Select the ArchiCAD file you saved to your computer from

Step 22 or select the file named Step-22.pln contained in
the Step Files folder. Click the Open button.

        

The Import Drawing dialog will appear displaying the
Project Documents view set we created in the previous steps.
We will use this dialog to selectively add drawings to the
layout. Let's start with the A1-Site Plan Layout.
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- Click the "Place Drawings on Current Layout".
- Check the Site Plan and the Ground Floor within the

Available View Sets.
- Click the Import button.

3. Place and Position the Drawings on the Layout

After you click the Import button, PlotMaker will place the
drawing at the lower left corner of the sheet.
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At this point you can select the drawing and compose it.
- Select the Arrow Tool from the Toolbox.

- Click the corner of the placed drawing to highlight it
- Select Drag from the Edit menu.

- Click within the drawing and drag to locate the drawing on
the sheet.

The next step is to place and position the drawings for the
remaining layouts. To do this, repeat the above steps to
complete this process for A2-Floor Plans, A3-Ceiling Plans and
A4-Elevations & Sections.



132

Step 24: Placing, Positioning and Viewing Drawings

Graphisoft ArchiCAD Step by Step Tutorial

4. Add Drawing Title and Scale

To finish the layouts we need to add a drawing title and scale
as well as a sheet number.

- Select and open the Text Tool in the Toolbox.

- In the Text Settings dialog set the text size to 18 point
(6mm) and click OK.

- Double click the cursor where you would like the title to
begin.

- When the flashing cursor appears, begin typing the
drawing title.

Repeat the above steps for each of the drawing titles in each
of the layouts. Use the same steps to create the scale text, but
set the font size to 12 point (4mm).

You may also wish to select the Line Tool to draw a line
between the title and scale. The finished layouts should look
as follows:
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Step 25: Publishing, Printing and Plotting
Overview

Both ArchiCAD and PlotMaker contain a Publisher feature. The purpose of the Publisher is to set custom View Sets describing
how to publish a drawing using plotters, printers, AutoCAD, DXF files and the Internet.

The Publisher can process individual drawings or an entire set of documents.

Process to Learn

• Creating View Sets

• Publishing
Save as Files

Upload to Internet
Print

Plot
• Working with AutoCAD

Starting the Step

Use your file from the previous step or open the file named Step-25.lbk contained in the Step Files folder.
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Introduction
PlotMaker uses the Publisher function familiar from
ArchiCAD. Part or all of a Layout Book can be printed, plotted,
saved, or published to the Internet. The Publisher command is
found in the File menu. The left side of the Publisher dialog
box shows the Layout Book tree structure, while the right
side contains the Publisher settings (as in ArchiCAD).

The save options used by PlotMaker are generally recognized
by ArchiCAD (EPS, DXF, DWG, DWF). PlotMaker supports all
the popular raster plotters and laser printers through
specific drivers and settings.

PlotMaker uses a new printing/plotting method in which the
Layout size (represented by the blue frame), optimized for a
particular printing/plotting tool and paper size, can differ
from the actual output produced by the printer or plotter. This
means that you can change the print scale. For example, a
Layout Book optimized for a plotter using A1 paper can also
be printed, properly scaled down, on an A3 printer.

What to Do

1. Create View Sets for Publishing

The Publisher function within PlotMaker is used to set custom
View Sets describing how to publish a drawing (i.e. for a
client, a consultant, or a presentation). In this exercise we will
create View Sets with custom settings for publishing to the
client, the consultants, printing and plotting.

 P-6, S-25, M-A

- Go to the File menu and select the Publish option from
Publisher within the pull-down menu and click the "Untitled"
View Set and select Rename from the popup menu.

- Rename the View Set as "Consultants" and click OK.

- Now click the "Consultants" View Set and select New Set
from the popup menu and Enter "Client" as the name for
the new View Set.

- Repeat this step and create 2 additional View Sets and
name them as follows: "Printer" and "Plotter"

2. Assign Drawings to the View Sets

The purpose of Publisher View Sets is to create and save
settings for different publishing configurations. In this
exercise we will assign drawings to the View Sets created in
the previous exercise.

 P-6, S-25, M-B

• Configure the Plotter Publisher View Set: The settings
for a plotter can be saved with the drawing.

- Select the Plotter view set from the View Set popup menu.
- Click the View Set Publishing Properties button.
- Select Plot from the Publishing Method popup menu and

click the OK button.
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- Select and drag the "A1-Site Plan" from the Layout Book
window on the left side of the dialog to the window on the
right side.

- Repeat this step for the remaining layouts: A2-Floor Plan,
A3-Ceiling Plan and A4-Elevations & Sections.

- Click and highlight the A1-Site Plan. Click the Plot
Setup... and Plot Settings... buttons to configure your
plotter. Repeat this for the remaining drawings.

When you ready to Plot, simply select the Plotter View Set
and click the Publish button.

• Configure the Printer Publisher View Set: The settings
and setup for printing documents is similar to the previous
steps for plotter setup.

• Configure the Client Publisher View Set: Publishing
for a client can produce a variety of results from
presentation drawings to visualization to documents for
the Internet. For the purpose of this exercise, we will
publish drawings and images to be viewed with an
Internet browser such as Netscape or Internet Explorer.

- Select the Client view set from the View Set popup menu

- Click the View Set Publishing Properties... button
- Select Save Files from the Publishing Method popup

menu (this exercise could also use the Upload to Internet
option if we linked these documents to a web page).

- Click the Browse button, navigate to your computer's
Desktop and click the Make New Folder button. Type a
folder name called "For Client".

- Select the new folder and click OK.

- Click the option "Include Project Reviewer web
environment". This will allow the client to access the
documents and create markups through a web browser.

- Click OK.

- As you did previously, select and drag "A1-Site Plan" from
the Layout Book window on the left side of the dialog to
the window on the right side.

- Repeat this step for the remaining layouts; A2-Floor Plan,
A3-Ceiling Plan and A4-Elevations & Sections.

- Select each file and click the Format popup menu at the
bottom of the dialog.

- Scroll up and select the DWF format.

When you are ready to send these documents to your client,
select the Client View Set and click the Publish button. You
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can then attach the documents to an email or burn the
information onto a CD-ROM.

To view these documents, go to the folder you created on
your Desktop, "For Client," and double click the file
"Client.html." This file will open your default browser.

• Configure the Consultants Publisher View Set: When
you set the configuration for a consultant, the view set can
be saved with the consultant's file type defaults such as
AutoCAD DWG, Universal DXF or Microstation DGN.

- Select the Consultants view set from the View Set popup
menu.

- Click the View Set Publishing Properties... button.

- Select Save Files from the Publishing Method popup
menu (this exercise could also use the Upload to Internet
option if we wanted to upload the files to an FTP site).

- Click the Browse button, navigate to your computer's
Desktop and click the Make New Folder button. Type a
folder name called "For Consultants".

- Select the new folder and click OK.

- Since these documents will be published as AutoCAD
DWG files, we do not need to include the Project

Reviewer. Therefore, the "Include Project Reviewer web
environment" should be unchecked.

- Click OK.

- As you did previously, select and drag "A1-Site Plan" from
the Layout Book window on the left side of the dialog to
the window on the right side.

- Repeat this step for the remaining layouts; A2-Floor Plan,
A3-Ceiling Plan and A4-Elevations & Sections.

- Select each file and click the Format popup menu at the
bottom of the dialog.

- Scroll up and select the DWG format.
- You can set the AutoCAD translation defaults (i.e. version,

units, paper space/model space) by clicking the Options
button.

When you are ready to send these documents to your client,
select the Consultant View Set and click the Publish button.
You can then attach the documents to an email or burn the
information onto a CD-ROM.
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Part Seven: Detailing, Management and Archiving

Step 26: Detailing a Project
Overview

As a project grows into design development or construction documents, detailing is the next step in communicating the building
construction. ArchiCAD includes a Detail Tool that allows details to be linked to the virtual building model.

In this exercise we will locate detail markers on the plan and sections. We will then activate the new details from the Navigator
and add notes and information in the Detail Window.

Process to Learn

• Detail Tool

Selecting a Detail Marker
Placing a Detail

• Creating a Plan Detail
• Adding a Detail View Set

• Detail Views in the Navigator

Starting the Step

Open the file named Step-26.pln contained in the Step Files folder.
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Introduction
The Detail tool places parametric Detail Markers on floor
plans, sections and elevations.
These markers are linked to Detail Drawings, just like
Section/Elevation markers to their associated drawings.
Currently opened Detail Drawings are available from the
Window menu while all existing Details are accessible from
Project Navigator. They are publishable items.
The Detail Drawing consists of drawing primitives (i.e. lines
and fills), similar to Sections and Elevations. The user can add
dimensions and 2D elements. As in the case of a Section
Drawing, the drawing scale of the Detail Drawing can be set
independently of the scale of the Floor Plan.
Detail Drawings can either be generated from details of the
floor plan, sections and elevations, model based Detail
Drawings or Plain Drawings. The content of the Detail
Drawing can be generated by using the clipping polygon
surrounding the Detail Marker on the floor plan or section.
Regeneration does not occur automatically. Similarly to
drawing Sections, Detail Drawings can be regenerated by
using the appropriate Display menu commands.

What to Do

1. Set the View Set to "Floor Plan" using the Navigator

To set the View Set to the Floor Plan, click the View Sets tab
in the Navigator palette and double-click the "Ground Floor"
in the Floor Plan view set:

2. Edit the Scale and Zoom In to the Detail

Since this is a detail view, we need to change the scale and
zoom into the detail area of the floor plan.
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- Click the scale button at the bottom left of the Floor Plan
Window or Floor Plan Scale from the Options menu.

- Change the scale to 3"=1'-0" (1:5 mm).
- The view will change due to the scale change. Go to the

Display menu and select Fit in Window.

- Now select Zoom In from the Display menu and zoom to
the detail connection between the two sliding doors.

Hint: Notice that the detail of the door jamb has changed
to include trim around the door openings.

3. Edit the Layers in the Layer Settings Dialog

The layers are showing information that we do not wish to
include in a detail drawing. To change this information we
must edit the layers:

- Go to the Options menu and Layers. Select the Layer
Settings option.
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- Scroll through the Layers, select the layer names and click
the Hide or Show button as follows:

Hide these Layers:
• Furniture & Equipment

• Zones
Show these Layers:

• Fills
• Lines

- When finished, click OK.

4. Define and Place the Detail Marker

We are now ready to define the detail location and marker on
the floor plan. To do this we will use the Detail Tool from the
Toolbox.
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- Select and double-click the Detail Tool in the Toolbox to
open the Detail Settings dialog.

- Select the Detail Marker symbol from the popup menu as
shown below and click OK.

- Select the rectangle geometry method from the Info Box.

- Drag your cursor to the area you wish to detail. Click the
cursor once to begin drawing the rectangle and a second
time to finish.

- A hammer will appear. Click the hammer to locate the
center of the Detail Marker.

5. Open the Plan Detail from the Navigator

When a detail marker is placed on the floor plan using the
Detail Tool, a Detail is automatically generated in the
Navigator palette.

- Go to the Navigator palette and click the Project Map tab.
- Click the Details name to open the tree list. A new detail

will appear in the list called "D01".
- Double-click the "D01" detail to open the detail window.

      

6. Add Detail Information to the Detail

The Detail Window consists of drawing primitives (i.e. lines
and fills) that can be edited to create a final detail. The user
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can add dimensions and 2D elements to the detail, similar to a
Section/Elevation drawing.

 P-7, S-26, M-C, 6-7

- With the Detail Window active, select the Line Tool and
draw a line on both sides of the door to indicate the inside
line of the threshold. (Hold down the shift key to constrain
the line).

- Select the Arrow tool and select the fill pattern inside the
wall so that its four corners are highlighted.

- Delete the fill pattern by selecting the on the keyboard. We
can now add structural detail to the inside of the wall.

- Select the Line Tool.

- Select the Offset command from the popup menu in the
Control Box.

- Click the upper left side of the wall (point no. 1) and then
click the upper right side of the wall (point no. 2) as shown.

- Now offset a line to represent the edge of the 5/8" (25mm)
Gypsum Board. Drag the cursor down in the direction to
offset (no 3) and enter a 5/8" (25mm) dimension in the "R"
portion of the Coordinate Box. To confirm, select the Enter
key (Windows) or Return key (Mac).

- Repeat the last step and offset a line on the opposite side
of the wall to represent the edge of the face brick. Use 3 1/
2" (100mm) for the offset dimension.

- Now add a fill pattern to graphically show these
components. Open the Fill Tool and select Gypsum Board.

- Select the Magic Wand and click inside the area defining
the Gypsum Board. (You can also manually click the
cursor at each point to manually define the fill shape).

- Repeat the above step to select and place the Face Brick
fill pattern.

- Next, add some structural components to the wall. Select
and open the Object Tool.

- Draw the following details into the window with the Line
tool.

- Select the upper left insertion point and click OK.
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- Click your cursor in the bottom left corner of the gypsum
board (point no 1).

- Repeat this step for the opposite side of the wall.
- Finally, add 1/2" (20mm) plywood sheathing to the inside

of the 2x4 studs. Select the Line Tool and draw a line as
shown.

- Then offset the line and add a plywood fill as you did in
the previous steps.

7. Add Notes to the Detail

Now that the detail drawing is completed, we need to add
notes to communicate the information in the detail.

- Open the Line Tool.

- Select the Arrow at Start Point option and click the popup
button to select the Dot Arrow option. Click OK.

- Select the continuous line option from the Info Box.
- Click the start point, click the point where the leader starts,

and double-click the final point to finish the line.

- Open the Text Tool, select the bottom right text start point
and select the right justify button. Click OK.

- Double-click the cursor next to the end of the note leader.
A text cursor will begin to flash. Type in 5/8" Gypsum
Board.

- Repeat this step for the remaining leaders and notes.

8. Add the Detail to the Project Documents View Set

Finally, add the D01 Detail to the Project Documents View
Set. This will allow us to access the detail as a drawing in
PlotMaker.

To do this, click the View Sets tab in the Navigator palette,
select the Drawings folder so that it is highlighted and choose
Create New Folder from the popup menu. Name the new
folder "Details". This is where our project details will be
stored. If you want to move the Details folder so that it is
organized alphabetically, click to highlight the folder, then
drag it to the desired location.
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With the detail folder selected, choose "Save Current View"
from the popup menu. Use the defaults and click "Save".
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Step 27: Reviewing a Project
Overview

This exercise will demonstrate how to use the Mark-Up Tools command to enter commentary both visually and in words on
an existing ArchiCAD Virtual Building design.

Mark-Up Tools are intended to facilitate communication among project members and designers during a project.

Process to Learn

• Mark-Up Tools

• Adding a Markup Entry
• Highlighting a Correction

• Creating a Discussion
• Correcting a Markup

• Closing an Issue

Starting the Step

Open the file named Step-27.pln in the Step Files folder.
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Introduction
You may wish to mark up a design for many reasons - for
example, to correct and manage a colleague’s errors or
deviations from a project’s guidelines, or to make alternative
design suggestions. More than one person can mark up a
drawing.
Project Mark-Up supports several different commentaries by
allowing the use of different colors and highlights for each
separate issue.

What to Do

1. Create a Mark-Up Entry

The Mark-Up Tools can be used to redline an area that needs
to be changed or to highlight an element.

 P-7, S-27, M-A,1-3

- Zoom into the upper left corner of the building.
- Select the Arrow Tool and highlight the entry wall by

clicking one of the corners.

- With the wall highlighted, go to the File menu and select
Show Mark-Up Tools from the pull down menu.

- Click the Add Entry button in the Mark-Up Entries
section of the Mark-Up Tools dialog.

- In the text field of the New Markup Entry dialog, type in
the name "Entry Door".

The entry door needs a new door style, so we need to
highlight the entry wall as an element that needs to be
corrected.

- With the entry wall highlighted, click the Turn into
Corrections button. This will change the color and status
of the wall.

- Click and open the Tag and Discussion section at the
bottom of the Mark-Up Tools dialog.

- Type in "Client does not like the door style" in the text box
- Click "Place on Plan" and click the cursor at the center of

the door to place the note.

    



145

Step 27: Reviewing a Project

Graphisoft ArchiCAD Step by Step Tutorial

2. Correct the Mark-Up Entry

The purpose of mark-ups is to identify elements of the project
that need correction. Project elements can be corrected while
the mark-up is still active.

- Select the Arrow Tool and highlight the door by clicking
one of the corners.

- With the door highlighted, double-click the Door Tool
and change the door style to Style 3 within the Panel,
Sidelight, Shutter and Handle Types section of the dialog.

3. Close the Mark-Up Entry

When a Mark-Up Entry is corrected, the mark-up highlight and
notes can be turned off while retaining the history of the issue.

- Select the Arrow Tool and highlight the entry wall by
clicking one of the corners.

- Go to the Mark-Up Tools dialog and click the Remove
Corrections button. This will restore the wall to its
original pen color and line weight.

- Finally, turn this issue OFF by clicking the Eye icon to
closed next to the Entry Door mark-up entry.
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Step 28: Managing a Teamwork Project
Overview

Step 28 demonstrates how team members can access a shared model file. Teamwork commands allow a team member to sign
out specific layers from the model while retaining a reference to other parts of the project.

When changes are made, the model is updated by sending changes to the master model.

Note: If you only have a demo version of ArchiCAD, you will not be able to do this exercise as described here, because the
demo version does not contain Teamwork functionality.

Process to Learn

• Rules of Team Members

• Sharing a Project
Signing In to a Project

Sending and Receiving Changes
Project Sharing Info

• Signing Out of a Project
• Types of TeamWork Files

• Changing Workspace

Starting the Step

Open the file named Step-28.pln contained in the Step Files folder.



148

Step 28: Managing a Teamwork Project

Graphisoft ArchiCAD Step by Step Tutorial

Introduction
There are five possible roles in ArchiCAD for Teamwork:

• Administrator: The person who coordinates the team
and first shares the project. There can only be one
Administrator. When signed in as the Administrator, it is
not possible to work on the project or reserve areas.

• Team Leader: The person responsible for the project.
They can modify and create layers, stories, pens, units, etc.
Only one person can be signed in as Team Leader at any
one time.

• Teammate: Any team member working on any part of the
shared project.

• Mark-Up: If you intend to solely mark up the project, an
additional option is available to provide you work in Mark
Up Only mode. In this case your contribution will be
limited to drawing corrections and highlight elements.

• Viewer: Anyone able to access the shared project through
the network, but their modifications do not appear in the
Team Project.

What to Do

1. Sharing the Project
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When you have finished making the necessary preparations,
you can share the project with the other members of the team.

• Create Administrator and Team Leader: With the
ArchiCAD tutorial file open, choose Share This Project
from the Teamwork Menu. Click on Set Key Passwords.
Enter the Administrator Name and then click on Set
Administrator Password and enter a password. You will
be required to verify the password. Now click Set Team
Leader Password and repeat the same steps. Now click
OK in the Set Key Passwords dialog.

      

• Share the Project: In the Project Sharing Setup, click
Share. Enter the required password. You are prompted to
save the .PLP file. Save the file in the appropriate location.
This is the Team Project file. The project can now be
signed into.

2. Signing into a Project

Once the project has been shared, teammates can start signing
in to it. Access to the project can either be free (depending on
the current network access privileges) or restricted by the
Administrator. In the latter case, only users identified by name
and an optional password are allowed to participate in the
work.



149

Step 28: Managing a Teamwork Project

Graphisoft ArchiCAD Step by Step Tutorial

• Sign In: Go to the ArchiCAD Menu and select
Teamwork/Sign In. Select the .PLP project file in the
dialog.

The Sign In dialog box appears. Select Teammate, and enter
a name and password. Click Set Password. The first time you
sign in, a prompt box asking you whether you want to
register as a Team Member will appear. Click on Yes.

3. Reserving a Workspace

After signing in to a Teamwork project, the Sign In Wizard
offers a set of options for reserving a part of the shared
project.

• Reserve Floor Plans: Click on the Next button to go to
the first option dialog box. Select the Stories and Layers
you wish to reserve. If you wish to reserve just part of the
project floor plan, click the Marquee Tool and select an
area of the Floor Plan. You will have exclusive rights to the
layers and marquee area that you reserve.
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• Reserve Sections/Elevations and Animation/VRs:
Click on the Next button to go to the Sections/
Elevations and Animation/VRs dialog box. Select the
appropriate parts to access.

• Review the Selected Workspace: Click on the Next
button to go to the last option dialog box. This box
displays a summary of the selected options that you can
review before signing in. Make any changes required by
clicking on the Previous button. When you are certain of
the Workspace options, click Sign In.

            

4. Working within a Reserved Workspace

Elements inside the reserved area can be freely modified or
deleted by the teammate who has made the reservations.
Elements that are locked, reserved by others or not reserved
at all cannot be modified, but can be viewed in all windows
(Floor Plan, 3D Window, Sections/Elevations, lists). These
elements can be selected, their settings dialog boxes can be
viewed, their parameters can be copied from there or picked
up by Option/Alt-clicking the element.

5. Sharing Info

During the course of being signed into a project, the status of
Team Members’ access details and status can be easily checked.

• Check Project Sharing Info: Go to the Teamwork
Menu and select Project Sharing Info. A window
appears that shows a list of Team Members and their sign-
in status. Select a Team Member to view their sign-in
details.

6. Sending and Receiving Changes

Changes made by any team member are sent to the shared
Team Project by choosing the Send and Receive Changes
command from the Teamwork Menu, or (optionally) when
signing out. Changes sent to the Team Project do not appear
automatically in other teammates’ copies. To see changes
made by another teammate, choose Receive Changes.
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7. Working on a Local Copy

Some team members may need to work at home or in a
remote location. In this case, the solution is to make a local
draft copy of the Shared Project, preserving the sign-in
reservations made.

• Creating a Local Copy: To create a local draft copy of
the Shared Project, choose the Save as... command from
the File Menu. The created file can be opened similarly to
a Solo Project by choosing File/Open and the Draft
option or by double-clicking the file. This file contains all
the relevant data about the Team Project, including the
reservations made by the Teammate.

8. Change My Workspace

If a teammate needs access to a layer or area you have
reserved, you can change your workspace by selecting
Change My Workspace from the Teamwork Menu. When
the dialog appears, you may select new layers or release
currently selected layers for other team members.

9. Signing Out of a Project

Choosing this command breaks contact with the Team Project
and releases your reserved workspace for other teammates
who may wish to sign into it. If you have made any changes,
you are prompted to send them in. If you choose No in this
dialog box, your changes will be lost.
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Step 29: Archiving a Project
Overview

At the end of a project it is important to archive your project model and its associated library. To do this, ArchiCAD offers an
archive feature that embeds the library parts into a single model file.

Note: If you only have a demo version of ArchiCAD, you will not be able to do this exercise as described here, because
saving files is not available in the demo version.

Process to Learn

• What is an Archive?
• Archive

Saving an Archive
Open an Archive

• Archive Library
Using an Archive File as a Library

Creating an Archive Library
Selecting a Library

Starting the Step

Open the file named Step-29.pln contained in the Step Files folder.
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Introduction
ArchiCAD Projects may refer to a number of items called
Library Parts, stored as outside files in Library folders or
directories. You need to designate one or more active libraries
when starting a project. If you then open the project in
another environment (for example on a different computer),
these outside files may be missing.

If you want to ensure that all files referenced in the project are
included, you should use the Save As.../ArchiCAD Archive
Project… command. Documents saved as Archives are stored
together with all the Library Parts and properties contained
by and defined with the project.

This format is commonly used for saving backups, archives
and portable documents of your work.

What to Do

1. Saving as an Archive File

 P-7, S-29, M-A

If you are ready to save an Archive of your project, go to the
File Menu select Save As..

- In the Save As Type popup menu, select the ArchiCAD
Archive Project option. The file will be saved with a .PLA
extension.

- Click the Options button. This dialog provides Archive
Options that allow you to customize how the file is saved
and what is saved with the file.

- Use the defaults and click OK.
- Choose a location on your computer for the Archive file

and click the Save button.

2. Opening an Archive File

When you open an Archive type document using the Project
format in the Open dialog box, you can choose from several
Active Library Usage options. The archive library contains all
the items and properties used with the project, but none
other.

- Choose the Open... option from the File menu
- Select and Open the Archive file you created

- An Active Library Usage dialog box will appear with
several options. Choose the first option, "Read Elements
Directly from Archive". This option will not extract the
library embedded in the archive file but instead will
preserve the archive format.

    

If you should need to extract the archive library or need to
reference a different library, select one of the other two
options; "Extract elements to a new folder" or "Select a
library".
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